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PROGRAM OUTCOMES(POs)

Program Outcomes as defined by NBA (PO) Engineering Graduates will be able to:

1. Engineering knowledge: Apply the knowledge of mathematics, science, engineering
fundamentals, and an engineering specialization to the solution of complex engineering
problems.

2. Problem analysis: Identify, formulate, review research literature, and analyze complex
engineering problems reaching substantiated conclusions using first principles of mathematics,
natural sciences, and engineering sciences.

3. Design/development of solutions: Design solutions for complex engineering problems and
design system components or processes that meet the specified needs with appropriate
consideration for the public health and safety, and the cultural, societal, and environmental
considerations.

4. Conduct investigations of complex problems: Use research-based knowledge and research
methods including design of experiments, analysis and interpretation of data, and synthesis of
the information to provide valid conclusions.

5. Modern tool usage: Create, select, and apply appropriate techniques, resources, and modern
engineering and IT tools including prediction and modeling to complex engineering activities
with an understanding of the limitations.

6. The engineer and society: Apply reasoning informed by the contextual knowledge to assess
societal, health, safety, legal and cultural issues and the consequent responsibilities relevant to
the professional engineering practice.

7. Environment and sustainability: Understand the impact of the professional engineering
solutions in societal and environmental contexts, and demonstrate the knowledge of, and need
for sustainable development.

8. Ethics: Apply ethical principles and commit to professional ethics and responsibilities and
norms of the engineering practice.

9. Individual and team work: Function effectively as an individual, and as a member or leader in
diverse teams, and in multidisciplinary settings.

10. Communication: Communicate effectively on complex engineering activities with the
engineering community and with society at large, such as, being able to comprehend and write
effective reports and design documentation, make effective presentations, and give and receive
clear instructions.

- - '

11. Project management and finance: Bloom’s Taxonomy
Demonstrate knowledge  and o Producsnow orngnaiwr |
understanding of the engineering and T e R
management principles and apply EVATUBTD. e wton st s mins st ot it v
these to one’s own work, as a Draw connections among ideas ,
member and leader in a team, to analyze periment, qoestm tex e examne
manage p I‘Oj ects and in Use information in new situations

- . . . . ' 3 \ execute, imp solve, use, interpret, operate,
multidisciplinary environments. apply schedue, sketh e

¢ Explain ideas or concepts

u n d e rsta nd ‘\%z\\é classity, describe, discuss, explain, identify, locate, recognize,

report, select, translate

12. Life-long learning: Recognize the
need for, and have the preparation ‘ .
and ability to engage in independent 4 remember D et et e
and life-long learning in the broadest
context of technological change.
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Vision ( College)

To nurture talent and enrich society through excellence in technical education, research and

innovation.

Mission ( College )

VVVY 'V

To augment innovative pedagogy and kindle quest for interdisciplinary learning and
to enhance conceptual understanding.

To build competence, professional ethics and develop entrepreneurial Thinking.

To strengthen industry institute partnership and explore global collaborations.

To inculcate culture of socially responsible citizenship.

To focus on holistic and sustainable development.

Vision ( Dept)

To excel in imparting Civil Engineering knowledge of global standards in meeting societal
and environmental challenges with professional ethics

Mission ( Dept)

To develop entrepreneurial and skill and team work among students.

To inculcate basics of civil engineering knowledge to meet the professional
challenges through research and innovation in collaboration with industries.

To cultivate qualities of professional ethics and commitment towards welfare of the
society and environment.

Program Educational Objectives (PEO)

To design and utilize new materials, processes, and projects through research and

PEO1 .
development for the welfare of society.

PEO2 To communicate feasible technical solutions for civil engineering problems faced
by public through presentations and demonstrations.

PEO3 To participate in lifelong learning activities through constructive interactions with
stake holders.

Program Specific Outcomes ( PSO )

PSO 1 Graduates will be able to plan, analyse and design in order to execute and maintain
civil engineering structures using alternative materials and innovative construction
practices for sustainable infrastructural development of the nation.

PSO 2 Graduates will be able to pursue career opportunities for personal and professional

growth by demonstrating leadership skill, professional integrity and solve issues

related to civil engineering and allied fields.

Dept. of Civil Engineering, KLS’s VDIT, Haliyal
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CO’s And PO’s Mapping Chart

Subject with code: Design of RCC Structures (BCV601)

Semester: 6%

AY:2024-25

S.No

Description

PO1

PO2

PO4 PO5

PO6

PO7

PO8

PO9

PO10

PO11

PO12

PSO1

PSO2

Understand the
design  philosophy
and principles

Solve  engineering
problems of RC
elements subjected to
flexure, shear and
torsion.

Demonstrate the
procedural knowledge
in designs of RC
structural  elements
such as slabs, stair
case, columns and
footings.

Owns  professional
and ethical
responsibility.

Degree of compliance

Low:1

Medium:2

Dept. of Civil Engineering, KLS’s VDIT, Haliyal

High:3
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Mapping of Experiments with CO, PO and PSO

BCV601

Experiment Details CcoO PO PSO
PART — A : CONCRETE LAB
Module — 1: Tests on Cement
1 Calculation of deflection of singly reinforced beam 9 2,5
using Excel
5 Design of a simply supported RCC singly reinforced 3 3,5 1
beam using Excel and draw the reinforcement details
3 Design of a simply supported RCC doubly reinforced 3 3,5 1
beam using Excel and draw the reinforcement details
Design of singly reinforced beams with check for 3,5 1
4 | shear, check for development length and other 3
Checks using excel.
5 Design of a cantilever beam using excel and draw the 3 3,5 1
reinforcement
Design a simply supported rcc one way slab with 3,5 1
6 | intermediate support and draw the reinforcement 3
Details
Design a two-way slab for the given data and prepare 3,5 1
7 . 3
bar bending schedule
8 Design a short axially loaded RC column using Excel 3 3.5 1
9 Design the reinforcement for RCC square column with 3 3,5 1
isolated square footing
Design the reinforcement for RCC circular column 3,5 1
10 - . 3
with isolated square footing
Creation of models related to RC Structural elements. 5
11 . 3
(Demonstration)

Dept. of Civil Engineering, KLS’s VDIT, Haliyal
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EXPERIMENT WISE LESSON PLAN

Experiment No.1

Name Calculation of deflection of singly reinforced beam using Excel [ Ls, L4 ]
" e To learn excel tools and functional formulas and to calculate deflection
Objectives i
using excel
Experiment No.2
Name Design of a simply supported RCC singly reinforced beam using Excel and draw
the reinforcement details [ L4, Ls.Ls ]
—— e To learn excel tools and functional formulas and to design SS RCC
Objectives . . .
singly reinforced beam using excel
Experiment No.3
Name Design of a simply supported RCC doubly reinforced beam using Excel and
draw the reinforcement details [ L4, L5, L6]
I e To learn excel tools and functional formulas and to design SS RCC
Objectives . .
doubly reinforced beam using excel
Experiment No.4
NEa Design of singly reinforced beams with check for shear, check for development
length and other Checks using excel.. [ L2, L3]
I e To learn excel tools and functional formulas to design Singly reinforced
Objectives .
beam with all the necessary checks.
Experiment No.5
Name Design of a cantilever beam using excel and draw the reinforcement[L4, Ls.L¢]
" e To learn excel tools and functional formulas and to design cantilever
Objectives .
beam using excel
Experiment No.6
NEi Design a simply supported rcc one way slab with intermediate support and draw
the reinforcement Details [ L4, Ls.Leg ]
" e To learn excel tools and functional formulas and to design one way slab
Objectives .
using excel
Experiment No.7
Design a two-way slab for the given data and prepare bar bending schedule
Name
[Las, Ls.Ls ]
I e To learn excel tools and functional formulas and to design two way slab
Objectives i
using excel
Experiment No.8
Name Design a short axially loaded RC column using Excel [ Ls, Ls.Ls ]
— e To learn excel tools and functional formulas and to design short axially
Objectives .
loaded column using excel
Experiment No.9
Name Design the reinforcement for RCC square column with isolated square footing

Dept. of Civil Engineering, KLS’s VDIT, Haliyal
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[Ls, Ls.Ls ]
" e To learn excel tools and functional formulas and to design RCC square
Objectives - ) .
column with isolated footing using excel
Experiment No.10
Design the reinforcement for RCC circular column with isolated square footing
Name
[La, Ls.Ls ]
—— e To learn excel tools and functional formulas and to design RCC circular
Objectives - ) .
column with isolated footing using excel
Experiment No.11
Creation of models related to RC Structural elements. (Demonstration)
Name
[Las, Ls.Ls ]
I e To create RCC structural models with all the theoretical knowledge and
Objectives

practical observations.

Dept. of Civil Engineering, KLS’s VDIT, Haliyal
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EXPERIMENT 1

Calculation of deflection of singly reinforced beam using Excel

Abeam 6 m long, simply supported at its ends, is carrying a point load of 50 KN at its centre.
The moment of inertia of the beam is 78 x 106 mm4 . If E for the material of the beam = 2.1

X 105 N/mmz2. calculate deflection at the centre of the beam and slope at the supports.

Solution:

GIVEN DATA:

L=6m

W =50 KN =50 X 10N
| =78 X 10 mm4
E =2.1X 105 N/mm?

SOLUTION:
DEFLECTION AT THE CENTRE OF THE BEAM,
yc =WL?/ 48 El
=50000 X 60003 /(48 X 2.1 X105 X 78 X 106 ) = 13.736 mm.
SLOPE AT THE SUPPORTS,
OA=6B =-WL2/16 EI =50000 X 60002 /(16 X 2.1 X 105 X 78 X 106 ) = 0.06868
radians.
Deflection Calculation
Simply Simply Cantilever Cantilever
supported beam supported beam beam with beam with
with UDL with Point Load UDL Point Load
Load W | 8 KN/m 70 KN/m 1400 KN/m 10 KN/m
Length I 2.60m 3.00m 3.80m 5.00 m
Elasticity of
Concrete = Ec | 22000000 MPa 22000000 MPa fAZF?E?OOOO ﬁAZF());)OOOO
5000(vfck)
Width b 0.20m 0.20m 1.50 m 0.20m
Depth d 0.45m 0.60 m 1.10 m 0.60 m
Moment M | 8.66 m 82.13 m 2601.46 m 40.63 m
Reaction R | 13.33m 109.50 m 2738.38 m 32.50 m
Moment of
Inertia = Ixx | 0.0015 mm4 0.0036 mm4 0.1664 mm4 0.0036 mm4
bd*/12
Deflection d 0.1 mm 0.5 mm 10.0 mm 5.3mm
Formula Y [ swi*/zsakl WI%/48EI WI*/8EI WI%/3EI
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Design of a simply supported RCC singly reinforced beam using Excel and
draw the reinforcement details

EXPERIMENT 2

A Reinforced concrete beam is to be designed over an effective span of 5m to support a
service load of 8 KN/m. adopts M20 grade concrete and Fe 415 HYSD bars

Step 1

Step 2

Step 3

Step 4

Given Data
Effective length 5 m
fo 20 N/mm?’
f, 415 N/mm?2
span to effective depth ratio 18
unit weight 25 kN/m?
Dimensions
Span/Effective=18, depth 0.27777778 m
277.777778 mm
Considering depth d 300 mm
Effective
cover cover d' 50 mm
Overall depth D 350 mm
035 m
Provide breadth b 230 mm
023 m
Load calculations
DL=Self Weight b*D*Ygec
DL 2.0125 kN/m
LL 8 kN/m
Total load w 10.0125 kN/m
Factored load W,=1.5xWu 15.01875 kN/m
Ultimate Moment and Ultimate shear
M, W, I/8
46.9335938 kNm
vy (Wl)/2
37.546875 kN
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Step 5
Limiting Moment of Resistance
Mlim = 0.138*f, *b*d’
= 57132000 Nmm
57.13 kNm
Muiim>My
The beam can be designed as singly reinforced beam
Step 6
Tensile Reinforcment
Ast = (((0.5*F4*b*d)/f,)*(1-sqrt(1-((4.6*Mu*10°%)/(fu*b*d?%)))))
= 512.13 mm’
Astpin = (0.85*b*d)/f,
= 141.3253012 mm’
Astnax = (0.04*b*D)
= 3220 mm?’
Astin<Ast<AStax
Step 7
Using 16mm diameter
bars
No of bars = (Ast/ast)
ast = n/4*16°
= 201.088 mm’
No of bars = 2.54679543
= 3

Provide 3 no'r of 16mm dia bars as tesion reinforcement
Provide 2 no'r of 10mm dia bars as hanger bars
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Step 8

Shear Reinforcement
Nominal shear stress T, = Vy/(b*d)
= 0.544 N/mm?2
Ast,ro = 3*(r/4)*16°
= 603.264 mm’
P: = 100Ast,./b*d
= 0.87429565
Design shear stress T, = 0.58 N/mm?2
T.<T,
Hence provide the nominal shear reinforcement
Consider 2 leg 6mm dia vertical stirrups
Asv = 2*(n/4)*6°
= 56.556 mm?’
Sv = (0.87*f,*Asv)/(0.4*b)
= 221.951563 mm
= 200 mm
Provide 2 legged 6mm diameter vertical stirrups at a distance of 200mm c/c
(Hanger bars) . {Hanger bars)
2-10mm ¢ gﬂzauis@ 175mm cfc i@ mm¢
e T
I y | D_300I Stirrups 2L-8 ¢ @
Clear I I mm 175 mm clc
cover L a
rgillne;’ﬁ Tension feinforcement b=200mm
- 2-12mmla — 2=12mm & bars
200m | = 3000 mm 200m (Tension reinforcement)
| | L=3200 mm | | Cross section (C/S)

Longitudinal

section (L/S)
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EXPERIMENT 3

Design of a simply supported RCC doubly reinforced beam using Excel and
draw the reinforcement details

Design a Reinforced concrete beam of Rectangular cross section to carry a Live load of
20KN/m. The clear span of the beam is 5.5m.The bearing at each end is 300mm.use M20

grade concrete and Fe415 steel.

Step 1
Given Data
Clear length 55 m
fo 20 N/mm?’
f, 415 N/mm2
span to effective depth ratio 18
unit weight 25 KN/m?
Bearing at each end 300 mm
LL 20 KN/m
Step 2
Dimensions
Span/Effective depth,
Depth= 0.30555556 m
305.555556 mm
Considering depth d 350 mm
035 m
Effective cover cover d' 50 mm
Overall depth D 400 mm
04 m
Provide breadth b 230 mm
023 m
Effective span
C/C distance bet the
support 58 m
Clear span+d 585 m
Lest 58 m
Step 3
Load calculations
DL=Self Weight b*D*Ygec
DL 2.3 kN/m
LL 20 kN/m
Total load W 22.3 kN/m
Factored load W, 33.45 kN/m
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Step 4

Step 5

Step 6

Ultimate Moment and Ultimate shear

My

Vu

W, /8
140.65725
(Wl)/2
97.005

kNm

kN

Limiting Moment of Resistance

M, lim 0.138*f *b*d’
77763000 Nmm
77.7 kNm
IVlulim<|V|u

The beam can be designed as douby reinforced beam

Tensile Reinforcement

Ast=Ast;+Ast,
Ast;

((Xu/d)im*0.36*b*d)/(0.87*f,)

2

770.552555 mm
(Mu=Muj,) = fsc*Asc*(d-d')
€ 2*¥10° N/mm?
XUmax 0.48*d

168 mm

fsc (0.0035* (XUmax-d") *€5)/XUnmax

491.666667 N/mm’
fsc 361.05 N/mm’
Asc 580.62 mm?
Asc=Ast, 580.62 mm?
Ast=Ast;+Ast, 1351.17256 mm?
Ast,eq 1351.17256 mm’
ASCreq 580.62 mm’
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Step 7

Step 8

Using 25mm diameter bars (Tesion R/F)
No of bars = (Ast/ast)
ast = /4*25°

= 490.9375 mm’
No of bars = 2.75222928

= 3
Using 16mm diameter bars (Compression
R/F)
No of bars = (Ast/ast)
ast = n/4*16*

= 201.088 mm’
No of bars = 2.88739258

= 3
Provide 3 bars of 25mm dia bars as tesion reinforcement
Provide 3 bars of 16mm dia bars as compression
reinforcement
Shear Reinforcement
Nominal shear stress T, = Vu/(b*d)

= 1.2 N/mm?
Astyro = 3*(/4)*25°

= 1472.8 mm’
AsCpro = 3*(n/4)*16°

= 603.26 mm’
P, = 100Ast,./b*d

= 1.829
Design shear stress T, = 0.76 N/mm?2

T,> T,

Hence design for shear reinforcement
Vu=Vuc+Vus
Vuc = t.*b*d

= 61180 N

61.1 KN
Vus = Vu-Vuc
35.905 KN

Using 2 leg 6mm diameter
Asv = 2*(n/4)*6°

= 56.55 mm’
Sv = (0.87*f,*Asv*d)/Vus

199027.493
199 mm
= 175 mm

Provide 2 legged 6mm diameter vertical stirrups at a distance of 175mm
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Step 9
Deflection Calculation
(L/d)aet = 0.01657143
= 16.5714286
(L/d)permissible = (L/d) max* K K *Ks
fs = 0.58f, (Astreq/ASt,ro)
= 220.83 N/mm?
Kk = 0.9
Pc = (100Asc,,)/(b*d)
0.75
Kc = 1.2
Kf 1
(L/d)permissible = 21.6
(L/d)act < (L/d)permissible

Hence the design is safe

(Hanger bars}
2=-12 mm o bars

Stirrups
2L=8 ¢ @ 300mm clc
Clea
c:o'.re[r\I I
Y
Clear _ I
cover i

@__

Tensionfreinforcement
3-20mml p bars

Clear span { = 5000 mm

|3DUI"H[T‘I
|

L=5300 mm

I3300mr'|

Longitudinal section (L/S)

D=500

mm

b:aonmfnm:%|

{Hanger bars)
2=12 mm ©

f— Stirrups

2l-8 9 @

3-20mm ¢ bars

(Tension reinforcement)

Cross section (C/S)

300 mm clc
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Design of singly reinforced beams with check for shear, check for development

EXPERIMENT 4

length and other checks using Excel.

A Reinforced concrete beam is to be designed over an effective span of 5m to support a
service load of 8 KN/m. adopts M20 grade concrete and Fe 415 HYSD bars

Step 1

Step 2

Step 3

Step 4

Given Data
Effective length 5 m
fo 20 N/mm?’
f, 415 N/mm?2
span to effective depth ratio 18
unit weight 25 kN/m?
Dimensions
Span/Effective=18, depth 0.27777778 m
277.777778 mm
Considering depth d 300 mm
Effective
cover cover d' 50 mm
Overall depth D 350 mm
035 m
Provide breadth b 230 mm
023 m
Load calculations
DL=Self Weight b*D*Ygec
DL 2.0125 kN/m
LL 8 kN/m
Total load w 10.0125 kN/m
Factored load W,=1.5xWu 15.01875 kN/m
Ultimate Moment and Ultimate shear
M, W, I/8
46.9335938 kNm
vy (Wl)/2
37.546875 kN
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Step 5

Step 6

Step 7

Limiting Moment of Resistance

M,lim = 0.138*f, *b*d’
= 57132000 Nmm
57.13 kNm
Mulim>Mu

The beam can be designed as singly reinforced beam

Tensile Reinforcment

Ast = (((0.5*F4*b*d)/f,)*(1-sqrt(1-((4.6*Mu*10°%)/(fu*b*d?%)))))
= 512.13 mm’

Astrin = (0.85*b*d)/f,
= 141.3253012 mm?’

Ast max = (0.04*b*D)
= 3220 mm’®

Astin<Ast<AStax

Using 16mm diameter

bars

No of bars = (Ast/ast)

ast = n/4*16°
= 201.088

No of bars = 2.54679543
= 3

mm

Provide 3 no'r of 16mm dia bars as tesion reinforcement
Provide 2 no'r of 10mm dia bars as hanger bars

10
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Step 8
Shear Reinforcement
Nominal shear stress T, = Vu/(b*d)
= 0.544 N/mm?2
Astpro = 3*(n/4)*16>
= 603.264 mm’
P, = 100Ast,./b*d
= 0.87429565
Design shear stress 1. = 0.58 N/mm?2
T<T,

Hence provide the nominal shear reinforcement

Consider 2 leg 6mm dia vertical stirrups

Asv = 2*(n/4)*6°
= 56.556 mm?*
Sv = (0.87*f,*Asv)/(0.4*b)
= 221.951563 mm
= 200 mm

Provide 2 legged 6mm diameter vertical stirrups at a distance of 200mm c/c
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EXPERIMENT 5

Design of a cantilever beam using Excel and draw the reinforcement

Design a cantilever beam of clear span 3.25m, service load 15KN/m. Use Fe415 steel, M20
concrete. Sketch the reinforcement details.

Given : clear span, [ = 3.25 m, live load = 15 kN/m
f,=20N/mm* and f =415 N/mm’
Step : 1 Selection of cross = seclional dimensions

(a) Effective depth of beam (d)

i = Clear span = ! = 3250 =464 28mm

7 7 7

say, d=5300mmor{d.5m [.. f!rm.‘_i et = 200 mm]
(b) Overall depth of beam (1)

D=d+d (Assume d' = 50 mm)

' D= 500 + 50 = 550 mm or 0.55m

{c) Width of beam (b)

1 2
bh=—xwd to —xd
3 3

Sob %XSEIEI 166.66mm

b % %500 = 33333mm

S Provide h=250mm or 0.25m
Beamn size = b x D = 250 x 550 mm
Step : 2 Caleulation of effective span (1)
effective depth (d)
2

Effective span (L) = clear span ([) +

S L=3254 %=3.‘im

Step : 3 Load calculation
1. Self weight of beam = b x D x density of RCC
=025 x0.55 % 25 =3.437 kN/m

=344 kN/m
2. Live load (Given) = 15.0 kN/m
Total load, W = 18.44 kN/m

.. Factored W" 1.5 W=15x1844=2766kNm
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Step : 4 Calculation of Maximum bending moment

Wi’ 2766 35
2
Step : 5 Check for effective depth

M, =0138f,bd’ For Fe 415 steel

M, = =16941 kN.mor 169.41 x 10° N.mm

Equating. er - M"r_

i
I | 16941x10  49550mm
© | 01387,

b N0138%x20%250
d =<d (500 mm), Design is safe, (ok)

ey provided
Step : 6 Calculation of main reinforcement

M, =01 33}"*&1'2 =0138%20x250% 500 =1725 kN.m

Section 1s under reinforced

M, =M,

Hence singly reinforced section is to be designed
Refer [5:456=2000, G=1.1(b)

fIVAST
M, =0877, A,,a'{l— [—]]
fabd

169.41% 10° = 087 X 415 % S00A,, 1_[%]
20% 250 % 500

209642 —1805254,, +16941x10° =0
A, =1162.84 mm*
® (Check for minimum reinforcement - clause 26.5.1.1(a)

085hd 085250500

A, = 256,02 mm’
- f 415
LAy = A, Hence (0k)
Now Assume 20 mm ¢ bars
. Area of one bar, ¢ =;¢2 =; %20" =314.15 mm*
A, 116284
No. of bars = a—‘" = 31415 - 370 say 4

£

Ay, ., =4Xx3415= 12566 mm’

. Provide 4-20 mm & bars at tension reinforcement (Top) and 2-12 mm 6 bars at compeession
rewnforcement (Bottom =| Assiine )
Step : 7 Design of shear reinforcement
® Desiga of shear force
V.=WL=2766x35=981 kN

v, _9681x10'

» Nominal shear stress, T, = N 20X O0TIN ! mm®
1004, 100x125
o Percentage of tensile sieel reinforcement, p, = hd’— = (::0 = s::‘)ﬁ
po=1%

Calculation of T, Refer 15:456-2000, table No, 19
using p, = 1% and [, = 20 Nfmm?
T = 0.62 N/inm’

Design shear strength, ‘T, ', Refer table No-20
using £ = 20 Nfmm’
LT 28 Nimm®
o Comparisons
(a) 1>t = Hence shear reinforcement 1s required
(1) Calculate shear carmed by concrete, V_ = ©id = 0,62 x 250 x 500 = TIS00 N
V_ = T7.5kN
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(i1) Calculate shear carried by stirrups, V, =V =V _=090681-775=1931 kN

spacing of stirrups should be least of the following three
087f A d

¥

V,

HE

1. S,
Assume 2L — 8mm ¢ vertical stirrups
Lt
AL =2x 7 » 8 = 10053 mm’

087 x415x100.53 %500
19.31x10°
2.8 #0754, o8 =0.75x500=375 mm
3.8 #300mm, -8 =300mm
say § =300 mm

S, =93983

. Provide 2L-8mm ¢ bars @ 300 mum cfc
(b) T, =>1,, —Designis safe (ok)
Step : 8 Check for deflection control

(a) Note down the percentage of steel provided, p = 1%
(b) stress in steel, Refer 15:450-2000, Fig 4

Ay 116284
058fF | —= |=058x415x . 22274 N/mm?*
f; =087 -“{ A, l 12566 o
read out the modification factor (k)
cok=1.15
L B
1. 7 n Tk, xk, xk; k.o =k;=1
" [5} Tx115x1x1=805

[Lj 3500
2 | = =——=7
d provided 400

(L] (LJ
ol — = —
\.d [TEY d provided

Hence deflection control is satishied, {(ok)
Step : 9 Development length or Anchorage length at supports
Refer IS:456=2000, clause 26.2.1

_ bo,
L= i1, where ¢, = 0.87 fy
087 1,0
" L” —_
41,
T,= | .2 N/mm?* — from clause 26.2.1.1

For deformed bars increased by 60%
ie, 7,=12x16

N 7 _ 08Tx415x20
o T T 12 %16

The main tension reinforcement is extended 1nto the column to a length of 500 mm and bent
down at 90" and extended upto 8 ¢ and 290 mn

e, L,=500+ 8 x 20+ 290 = 950 mm

= 94023 mm say 950mm
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Step : 10 Reinforcement details

t (Tension reinforcement)
420mm ¢ bars
RCC
column | 500 mm Clear span=1=3.25m [ |
I _[ |
90° bend ""‘-——-VA Y T
89=160mm A
: y | D=550mm Stirrups
280mm "
T?_-‘IEmm ¢ bars
(Hanger bars) b=250mm
2L-8mm ¢ @ 300mm c/c | W
$ (stirrups)
C/S of beam
L/S of beam
| 600 mm |
(Assume)

15
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EXPERIMENT 6

Design a simply supported RCC one way slab with intermediate support and

draw the reinforcement details

Design a Simply supported slab for the following parameters clear dimension of slab in plan
9mx4m.The slab is simply supported along 2 long edges. Live load = 4.5KN/m2, Finishing
load = 0.5KN/m2, Materials used M20 and Fe415, width of support 300mm.

Step 1
Given Data
fo = 20 N/mm’
f, = 415 N/mm?2
unit weight = 25 KN/m?
Width of
support = 300 mm
ly = 9 m
I = 4 m
Iy/1x = 2.25
LL = 45 KN/m?
Span to effective depth
ratio = 20
Step 2
Type of slab
(/1) =2.25>2
Hence the slab is to be designed as one way slab
Step 3
Dimensions
Span/Effective depth = 02 m
= 200 mm
Considering depth d = 200 mm
= 0.2 m
Effective cover d' = 25 mm
Overall depth D = 225 mm
= 0.225 m
Provide breadth
b = 1000 mm
1 m
Effective span (l,)
C/C distance bet the support = 43 m
Clear span +d = 42 m
Effective span (l,) =
C/C distance bet the support = 9.2 m
Clear span +d = 93 m

16
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| eff = 42 m
lyett = 9.2 m
Step 4
Load
calculations
DL=Self Weight = D*Ygee
DL = 5.625 KN/m’
LL = 4.5 KN/m?
FL = 0.5 KN/m’
Total load w = 10.625 KN/m
Factored load
W, = 15.9375 KN/m
Step 5
Ultimate Moment and Ultimate
shear
M, = W, I°/8
35.142188 kNm
vy = (Wul)/2
33.46875 kN
Step 6
Limiting Moment of Resistance
M,lim = 0.138*f, *b*d’
= 110400000 Nmm
110.4 kNm
Muim > My
Hence the depth provided id sufficient
Step 7
Tensile Reinforcment
Ast = (((0.5*fck*b*d)/fy)*(1—sqrt(l—((4.6*Mu*lOG)/fck*b*dz))))
= 514.09 mm’
Astin = 0.12%*b*D
= 270 mm’
Considering 12mm diameter bars
Spacing = ((m/4*102)/Ast,eq) *1000
= 220.02 mm
= 200 mm
Provide 12mm diameter bars at a spacing of 200mm c/c

17
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Step 8

Step 9

Step 10

Distribution
Reinforcement

Ast,i, should be
considered

Using 8mm diameter

Spacing

((rt/4*8%)/Ast i) ¥1000
186.19259 mm

Provide 8mm diameter bars at a spacing of 175mm c/c

Shear Reinforcement

Nominal shear stress T, = Vu/(b*d)

= 0.167 N/mm?2
Ast,r, = ((n/4*8%)/Spacing)*1000

= 565.56 mm?’
P, = 100Ast,./b*d

= 0.2827
Design shear stress 1, = 0.375 N/mm?2
K = 1.15

T.<K T,

No shear reinforcement should be provided
Deflection Calculation
(L/d)act = 0.021

= 21
(L/d)permissible = (L/d) max ™ Ke* K *K
fs = 0.58f,(Ast eq/Astpro)

= 218.19 N/mm’
Ke = 1.75 N/mm2
(L/d)permissible = 33

(L/d)act < (L/d)permissible

Hence the design is safe

18
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EXPERIMENT 7

Design a two-way slab for the given data and prepare Bar bending schedule

Design the Slab for a room of clear dimensions 4mx5m,width of support 300mm,Two
adjacent edges are discontinuous LL = 3KN/m2,FF = 1KN/ m2.Materials used M20 and
Fe415.Show reinforced details.

Step
1
Given Data
for = 20 N/mm?’
f, = 415 N/mm?2
unit weight = 25 KN/m?
Iy = 5 m
Iy = 4 m
Iy/1 = 1.25
FF = 1 KN/m?
LL = 3 KN/m?
Span to effective depth ratio = 35*0.8
Step
2
Type of slab
(/1) =1.25<2
Hence the slabis to be designed as two way slab
Step
3
Dimensions
Span/Effective depth = 0.1425 m
= 142.5 mm
Considering depth d = 125 mm
= 0.125 m
Effective cover d' = 25 mm
Overall depth D = 150 mm
= 0.15 m
Provide breadth b = 1000 mm
1 m
Effective span (l,)
C/C distance bet the support = 43 m
Clear span +d = 4125 m
Effective span (l,) =
C/C distance bet the support = 53 m
Clear span +d = 5125 m

20
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|yeft = 4125 m
lyest = 5125 m
Step
3
Load calculations
DL=Self Weight = D*Ygce
DL = 3.75 KN/m’
LL = 3 KN/m?
FL = 1 KN/m’
Total load w = 7.75 KN/m?
Factored load W,/m run = 11.625 KN/m
Step
4
Ulimate Bending Moment and Shear
Iyeft/ lyett = 1.24242424
+ve oy = 0.062
-ve Qy = 0.0466
+ve ay = 0.035
-ve ay = 0.047
My(-ve) = a ¥ W, *12
= 12.2640117 KN/m
M,(-ve) = o, * W, *1,2
= 9.29691211 KN/m
M, (+ve) = a, W, *,2
= 9.21778945 KN/m
M,(+ve) = o, * W, *1,2
6.92323242 KN/m
Step
5
Limiting Moment of Resistance
M,lim = 0.138*f,*b*d’
= 43125000 Nmm
43.125 kNm
Myim > M,
Hence the depth provided id sufficient
Step
6

Tesion Reinforcement

21
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Ast,(+ve)

Ast,(-ve)
Ast,(+ve)
Ast,(-ve)
Astin

Using 8mm diameter bars
Ast,(+ve)

Spacing

Ast,(-ve)
Spacing

Ast,(+ve)
Spacing

Ast,(-ve)
Spacing

Astpro

Ultimate Shear
\"

(((0.5*f4*b*d)/f,)*(1-SQRT(1-((4.6*Mu*10°) /f. *b*d?)))
211.77 mm’
(((0.5*f4*b*d)/f,)*(1-SQRT(1-((4.6*Mu*10°) /f. *b*d?)))
285.29 mm?2
(((0.5*f4*b*d)/f,)*(1-SQRT(1-((4.6*Mu*10°) /f, *b*d?)))
157.59 mm2
(((0.5*f4*b*d)/f,)*(1-SQRT(1-((4.6*Mu*10°) /f. *b*d?)))
213.65 mm2
0.12%*b*D

180 mm2

((1/4*8%)/Ast,q)*1000
237.38 mm

((1/4*8%)/Ast,eq)*1000
176.21 mm

((1/4*8%)/Ast,q)*1000
279.28 mm

((11/4%8%)/Ast,eq) *1000
2353 mm

((mt/4*8%)/Spacing)*1000

287.2686 mm’

(W *(r/(1+r)*(1/2))
16.85 KN

Step

Shear Reinforcement

Nominal shear stress T,

P

Design shear stress T,
K

T .<K T,

= Vy/(b*d)

= 0.1348 N/mm2
= 100Ast,,o/b*d

= 0.229

= 0.3432 N/mm2
= 13

No shear reinforcement should be provided
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Step
9

Step
10

Deflection Calculation
(L/d)act = 33
(L/d)permissible = (L/d)max*Kt*Kc*Kf
fs = 0.58f,(Ast eq/Astpro)
= 239.56 N/mm?’

Kq = 1.5 N/mm?2
(L/d)permissible = 42

(L/d)act < (L/d)permissible
Hence the design is safe
Torsion

Continuous edge

Discontinuous edge

3/8%* At ax
106.9838 mm?’
3/4%* Ast oy
213.9675 mm’

23
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EXPERIMENT 8

Design a short axially loaded RC column using Excel

Design the reinforcement in a column of size 400 mm x 600 mm subjected to an axial load of
2000 KN under service dead load and live load. The column has an unsupported length of 4.0
m and effectively held in position and restrained against rotation in both ends. Use M 25
concrete and Fe 415 steel.

Step 1: To check if the column is short or slender
Given

I = 4000 mm, b =400 mm and D = 600 mm.

Table 28 of IS 456 = lex = ley = 0.65(l) = 2600 mm.

So, we have

lex/D = 2600/600 = 4.33 < 12 ley/b = 2600/400 = 6.5 < 12

Hence, it is a short column.

Step 2: Minimum eccentricity

ex min = Greater of (lex/500 + D/30) and 20 mm = 25.2 mm

ey min = Greater of (ley/500 + b/30) and 20 mm =20 mm

0.05 D =0.05(600) = 30 mm > 25.2 mm (= ex min)

0.05 b = 0.05(400) = 20 mm =20 mm (= ey min)

Hence, the equation given in cl.39.3 of IS 456 (Eq.10.4) is applicable for the design here.

Step 3: Area of steel

Pu=0.4 fck Ac + 0.67 fy Asc

3000(103 ) = 0.4(25){(400)(600) — Asc} + 0.67(415) A
Asc = 2238.39 mm2

Provide 6-20 mm diameter and 2-16 mm diameter rods giving 2287 mm2 (> 2238.39 mm2 )
and p = 0.953 per cent, which is more than minimum percentage of 0.8 and less than
maximum percentage of 4.0. Hence, 0.k.
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Step 4: Lateral ties

The diameter of transverse reinforcement (lateral ties) is determined from cl.26.5.3.2 C-2 of
IS 456 as not less than (i) ¢ /4 and (ii) 6 mm. Here, ¢ = largest bar diameter used as
longitudinal reinforcement = 20 mm. So, the diameter of bars used as lateral ties = 6 mm.

The pitch of lateral ties, as per cl.26.5.3.2 C-1 of IS 456, should be not more than the least of

Q) the least lateral dimension of the column =400 mm

(i) sixteen times the smallest diameter of longitudinal reinforcement bar to be tied =
16(16) = 256 mm
(i) 300 mm

6T @ 250 cfc

400

A

26
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EXPERIMENT 9

Design the reinforcement for RCC square column with isolated square footing

Design an isolated footing for an R.C. column of size 300 mm x 300 mm which carries a
vertical load of 800 kN together with an uniaxial moment of 40 kN-m. The safe bearing
capacity of soil is 250 KN/m2. Use M25 concrete and Fe 415 steel.

Step 1: Size of footing

Load on column = 800 kN

Extra load at 10% of load due to self weight of soil = 80 kN
Hence, total load, P = 880 kN

Let us provide a square isolated footing, where L=B

Equating the maximum pressure of the footing to SBC of soil,

P+ M—SBC
A" E
880 0
i.e., —[74" %= 250

On solving the above equation, and taking the least and feasible value, B=2m
Hence, provide a square footing of size2mx 2 m

The maximum and minimum soil pressures are given by

800 40x6 __ kN kN
Pmax = 74’ T—— 230F< ZSOF O0.K.

800 40x6 kN
Pmin = ?— T-: 70m—2 > Zero O0.K.

Hence, factored upward pressures of soil are,

pu,max = 345 kN/m2 and pu,min = 255 kN/m2

Further, average pressure at the center of the footing is given by

pu,avg = 300 kN/m2

and, factored load, Pu = 900 kN, factored uniaxial moment, Mu = 60 kN-m

Step 2: Two way shear

Assume an uniform overall thickness of footing, D = 450 mm

Assuming 16 mm diameter bars for main steel, effective thickness of footing ‘d’ is
d=450-50-16 - 8=376 mm

The critical section for the two way shear or punching shear occurs at a distance of d/2 from
the face
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of the column , where a and b are the dimensions of the column.

| dr2

" d/?

di2 di2
Hence, punching area of footing = (a + d)2 = (0.30 + 0.376)2 = 0.457 m2

where a = b = side of column

Punching shear force = Factored load - (Factored average pressure x punching area of
footing)

=1200 - (300 x 0.457)

=1062.9 kN

Perimeter along the critical section = 4 (a+d) = 4 (300+ 376)

= 2704 mm

Therefore, nominal shear stress in punching or punching shear stress  V is computed as

Punching shear force

- perimeter x ef fective thickness
~ 1062.9 x 1000

2704 x 376

{y

= 1.05 N/mm?

Allowable shear stress=kS. £ C

where {¢ = 0.25 /f . = 0.25/25 = 1.25 N/mm?

and, ks = (0.5+ B¢) = (0.5 + 2%) =1.0 ; Hence, adopt k,=1

Thus, Allowable shear stress=ks.{c=1x1.25=1.25 N/mm2

Since the punching shear stress (1.05 N/mmz2) is less than the allowable shear stress (1.25
N/mmz2), the assumed thickness is sufficient to resist the punching shear force.

Hence, the assumed thickness of footing D = 450 mm is sufficient.

The effective depth for the lower layer of reinforcement, , d =450 - 50 - 8 = 392 mm, and

the effective depth for the upper layer of reinforcement, d =d =450 - 50 - 16 - 8 =376 mm.
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Step 3: Design for flexure The critical section for flexure occurs at the face of the column

7 -

-

850 mm

306.75 MPa

The projection of footing beyond the column face is treated as a cantilever slab subjected to
factored upward pressure of soil.

Factored maximum upward pressure of soil, pu,max = 345 kN/m2
Factored upward pressure of soil at critical section, pu = 306.75 KN/m2
Projection of footing beyond the column face, | = (2000 — 300)/2 = 850 mm

Bending moment at the critical section in the footing is

M, = [Total force] x [Distance of CG from critical section]

P (345 +306.75) (z X 345 + 306. 75) 0.85]
“‘[ 2 ) : ]x[ 345+ 306.75 3 1

M, = 119.11 kN-m/ m width of footing

The area of steel Ast can be determined using the following moment of resistance relation for
under reinforced condition given in Annex G — 1.1 b of IS 456 :2000.

,yAsl]

My =0.87f,A,d I1— T

415xAg

B -
119.11x10°=0.87x415x A, x 376 Il 000378238

Ast =914.30 mm2

The corresponding value of pt = 0.24 % Hence from flexure criterion, pt = 0.24 %

Step 4: One way shear

The critical section for one way shear occurs at a distance of ‘d’ from the face of the column

474 mm

N
255 M 345 MPa

327.1 MPa
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Factored maximum upward pressure of soil, pu,max = 345 kN/m2
Factored upward pressure of soil at critical section, pu = 327.1 kN/m2
For the cantilever slab, total Shear Force along critical section
considering the entire width B is

V, = [Total force ] x [(1 —d) xB]
vu

345+ 327.1
= [f] x [(0.85 —0.376) x 2]

V,=318.58 kN

The nominal shear stress is given by
V, 318.58x1000
v =

W SO ALY 0 2
“Rd- 20005376 O N/mm

From 19 of IS 456 :2000, find the pt required to have a minimum design shear strength
{C =V =0.42 N/mm?2 with fck =25 N/mm?2 .

For pt = 0.365 % the design shear strength {C is 0.42 N/mm2 = {V = 0.42 N/mm?2 .
Hence from one way shear criterion, pt = 0.365 % Comparing pt from flexure and one way

shear criterion, provide pt = 0.365 % (larger of the two values)

Hence, Ay = 2 bd =22 1000 x 376 = 1372.4 mm’

Provide ¢ 16 mm dia bars at 140 mm c/c. Therefore, Ast provided = 1436 mm2 > Ast
required (1372.4 mm2).

Hence O.K.
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EXPERIMENT 10

Design the reinforcement for RCC circular column with isolated square footing

Design a circular column of 400 mm diameter with helical reinforcement subjected to an
axial load of 1500 kKN under service load and live load. The column has an unsupported
length of 3 m effectively held in position at both ends but not restrained against rotation. Use
M 25 concrete and Fe 415 steel.

Step 1: To check the slenderness ratio

Given data are: unsupported length 1 = 3000 mm, D =400 mm.

Table 28 of Annex E of IS 456 gives effective length I = 1= 3000 mm,
Therefore, 1/D = 7.5 < 12 confirms that it is a short column.

Step 2: Minimum eccentricity

emin = Greater of (1/500 + D/30) or 20 mm =20 mm

0.05 D = 0.05(400) = 20 mm

As per cl.39.3 of IS 456, eni, should not exceed 0.05D to employ the equation given in that
clause for the design. Here, both the eccentricities are the same. So, we can use the equation
given in that clause of IS 456 i.e., Eq.10.8 for the design.

Step 3: Area of steel

From Eqg.10.8, we have

Py = 1.05(0.4 fy Ac+ 0.67 f, Agc) ... (10.8)

Ac=Ag— A= 125714.29 - Ay

1.5(1500)(10%) = 1.05{0.4(25)(125714.29 — As) + 0.67(415) Asc}
Asc = 3304.29 mm?,

Provide 11 nos. of 20 mm diameter bars (= 3455 mm?) as longitudinal reinforcement giving p
= 2.75%. This p is between 0.8 (minimum) and 4 (maximum) per cents.

Hence o.k.
Step 4: Lateral ties

It has been mentioned in sec.10.22.4 that the pitch p of the helix determined from Eq.10.11
automatically takes care of the cl.39.4.1 of IS 456. Therefore, the pitch is calculated from
EQ.10.11 selecting the diameter of helical reinforcement from cl.26.5.3.2 d-2 of IS 456.
However, automatic satisfaction of cl.39.4.1 of IS 456 is also checked here for confirmation.

Diameter of helical reinforcement (cl.26.5.3.2 d-2) shall be not less than greater of
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Q) one-fourth of the diameter of largest longitudinal bar, and
(i) 6 mm.

Therefore, with 20 mm diameter bars as longitudinal reinforcement, the diameter of
helical reinforcement = 6 mm.
From Eqg.10.11, we have

Pitch of helix p < 11.1(DC- Spo) aSp fy/(D2 -...(10.11) ckefD )2 2 2
where DC: 400 — 40 — 402: 320 mm, spp = 6 mm, asIO =28 mm, fy: 415 N/mm , D =
400 mm and fck: 25 N/mm .

So, p < 11.1(320 — 6) (28) (415)/(4002— 3202) (25) <28.125 mm

As per cl.26.5.3.2 d-1, the maximum pitch is the lesser of 75 mm and 320/6 = 53.34 mm and
the minimum pitch is lesser of 25 mm and 3(6) = 18 mm. We adopt pitch = 25 mm which is
within the range of 18 mm and 53.34 mm. So, provide 6 mm bars @ 25 mm pitch forming
the helix.

Checking of cl. 39.4.1 of IS 456

Volume of helical reinforcement in one loop = 27632 mm?®and

Volume of core in one loop = 2011428.571 mm?®.

Their ratio = 27632/2011428.571 = 0.0137375

0.36(Ag/Ac— 1) (fu/fy) = 0.012198795

It is, thus, seen that the above ratio (0.0137375) is not less than 0.36(Ag/Ac— 1) (fa/fy).

\ersion

6T @ 25 cle
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EXPERIMENT 11

Creation of models related to RC Structural elements. (Demonstration)

RC structural Model of Slab
RC structural Model of Column
RC structural Model of Beam Column Joint

RC structural Model of Beams
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PROGRAM OUTCOMES(POs)

Program Outcomes as defined by NBA (PO) Engineering Graduates will be able to:

1. Engineering knowledge: Apply the knowledge of mathematics, science, engineering
fundamentals, and an engineering specialization to the solution of complex engineering
problems.

2. Problem analysis: Identify, formulate, review research literature, and analyze complex
engineering problems reaching substantiated conclusions using first principles of mathematics,
natural sciences, and engineering sciences.

3. Design/development of solutions: Design solutions for complex engineering problems and
design system components or processes that meet the specified needs with appropriate
consideration for the public health and safety, and the cultural, societal, and environmental
considerations.

4. Conduct investigations of complex problems: Use research-based knowledge and research
methods including design of experiments, analysis and interpretation of data, and synthesis of
the information to provide valid conclusions.

5. Modern tool usage: Create, select, and apply appropriate techniques, resources, and modern
engineering and IT tools including prediction and modeling to complex engineering activities
with an understanding of the limitations.

6. The engineer and society: Apply reasoning informed by the contextual knowledge to assess
societal, health, safety, legal and cultural issues and the consequent responsibilities relevant to
the professional engineering practice.

7. Environment and sustainability: Understand the impact of the professional engineering
solutions in societal and environmental contexts, and demonstrate the knowledge of, and need
for sustainable development.

8. Ethics: Apply ethical principles and commit to professional ethics and responsibilities and
norms of the engineering practice.

9. Individual and team work: Function effectively as an individual, and as a member or leader in
diverse teams, and in multidisciplinary settings.

10. Communication: Communicate effectively on complex engineering activities with the
engineering community and with society at large, such as, being able to comprehend and write
effective reports and design documentation, make effective presentations, and give and receive
clear instructions.

- - '

11. Project management and finance: Bloom’s Taxonomy
Demonstrate knowledge  and o Producsnow orngnaiwr |
understanding of the engineering and T e R
management principles and apply EVATUBTD. e wton st s mins st ot it v
these to one’s own work, as a Draw connections among ideas ,
member and leader in a team, to analyze periment, qoestm tex e examne
manage p I‘Oj ects and in Use information in new situations

- . . . . ' 3 \ execute, imp solve, use, interpret, operate,
multidisciplinary environments. apply schedue, sketh e

¢ Explain ideas or concepts

u n d e rsta nd ‘\%z\\é classity, describe, discuss, explain, identify, locate, recognize,

report, select, translate

12. Life-long learning: Recognize the
need for, and have the preparation ‘ .
and ability to engage in independent 4 remember D et et e
and life-long learning in the broadest
context of technological change.

Dept. of Civil Engineering, KLS’s VDIT, Haliyal
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Vision ( College)

To nurture talent and enrich society through excellence in technical education, research and

innovation.

Mission ( College )

VVVY 'V

To augment innovative pedagogy and kindle quest for interdisciplinary learning and
to enhance conceptual understanding.

To build competence, professional ethics and develop entrepreneurial Thinking.

To strengthen industry institute partnership and explore global collaborations.

To inculcate culture of socially responsible citizenship.

To focus on holistic and sustainable development.

Vision ( Dept)

To excel in imparting Civil Engineering knowledge of global standards in meeting societal
and environmental challenges with professional ethics

Mission ( Dept)

» To develop entrepreneurial and skill and team work among students.
» To inculcate basics of civil engineering knowledge to meet the professional

challenges through research and innovation in collaboration with industries.

> To cultivate qualities of professional ethics and commitment towards welfare of the

society and environment.

Program Educational Objectives (PEO)

To design and utilize new materials, processes, and projects through research and

PEO1 .
development for the welfare of society.

PEO2 To communicate feasible technical solutions for civil engineering problems faced
by public through presentations and demonstrations.

PEO3 To participate in lifelong learning activities through constructive interactions with
stake holders.

Program Specific Outcomes ( PSO )

PSO 1 Graduates will be able to plan, analyse and design in order to execute and maintain
civil engineering structures using alternative materials and innovative construction
practices for sustainable infrastructural development of the nation.

PSO 2 Graduates will be able to pursue career opportunities for personal and professional

growth by demonstrating leadership skill, professional integrity and solve issues

related to civil engineering and allied fields.
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CO’s And PO’s Mapping Chart

Subject with code: Design of RCC Structures (BCV601) AY:2024-25

Semester: 6%

SNo Description PO1 PO2 3 PO4 PO5 PO6 PO7 PO8 PO9 PO10 | PO11 | PO12 | PSO1 | PSO2

Use  software for
modelling, analysis and
design of structural
elements

Use of Project
Management software
2 | for Project planning 2 2 1 2 2
and scheduling of a
building project

Use of open source
software  for  GIS
3 | applications and to 2
create shape files.

Design using excel
spread sheet.

Degree of compliance Low:1 Medium:2 High:3
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Mapping of Experiments with CO, PO and PSO

Experiment Details CcO PO PSO

LAB
1 Analysis of plane trusses, continuous beams using 1 2,5 1
software
. : 2,5 1
2 | Analysis of portal frames using software 1
Understanding basic features of Project management 1,5,8,12 2

software. Constructing Project: create. WBS,
3 | Activities, and tasks and Computation Time using 2
Excel spread sheet and transferring the same to
Project management software.

Identification of Predecessor and Successor activities 1,5,8,12 2
4 | with constrain. Constructing Network diagram (AON 2
Diagram) and analyzing for Critical path,

Critical activities and Other non-Critical paths, 1,5,8,12 2
5 | Project duration, Floats. Study on various View 2
options available

Basic understanding about Resource Creation and 1,5,8,12 2
allocation g. Understanding about Splitting the
6 | activity, Linking multiple activity, assigning 2
Constrains, Merging Multiple projects, Creating
Baseline Project

GIS applications using open source software: To 5
create shape files for point, line and polygon features

! with a map as reference. To create decision maps for 3
specific purpose.
Computation of earthwork, Design of horizontal 3,5 1
8 | curve by offset method, Design of super elevation 4
Using Excel
9 Creating structural model and analysis of high rise 1 2,5 1
structures
10 Creating a model of building and the effect of earth 1 2,5 1
quake
2,5 1
11 | Create a model of large span roof and analyse 1
12 Crate a plan and set of structural drawings for a 1 2,5 1

multi-storied building
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EXPERIMENT WISE LESSON PLAN

Experiment No.1

Name Analysis of plane trusses, continuous beams using software[ L3,L4]
—— e To learn Structural analysis software and analyse the plane truss and
Objectives .
continues beam
Experiment No.2
Name Analysis of portal frames using software [ L3,L4 ]
Objectives e To learn Structural analysis software and analyse the portal frame
Experiment No.3,4,5,6
Name Project Management Software[ L3,L4,L5]
Obiectives e To understand and learn Project Management software tools and create
) a baseline project and to analyse critical activites
Experiment No.7
N Design of singly reinforced beams with check for shear, check for development
ame .
length and other Checks using excel.. [ L2, L3]
" e To learn excel tools and functional formulas to design Singly reinforced
Objectives .
beam with all the necessary checks.
Experiment No.5
Name Design of a cantilever beam using excel and draw the reinforcement[L4, Ls.L¢]
" e To learn excel tools and functional formulas and to design cantilever
Objectives .
beam using excel
Experiment No.6
NEa Design a simply supported rcc one way slab with intermediate support and draw
the reinforcement Details [ L4, Ls.Ls ]
" e To learn excel tools and functional formulas and to design one way slab
Objectives .
using excel
Experiment No.7
GIS applications using open source software: To create shape files for point, line
Name and polygon features with a map as reference. To create decision maps for
specific purpose. [L3,L4 ]
Objectives e To learn QGIS software tools and to create shape files.
Experiment No.8
Computation of earthwork, Design of horizontal curve by offset method, Design
Name : .
of super elevation Using Excel [ L3,L4,L5 ]
" e To learn excel tools and functional formulas and to compute earthwork ,
Objectives

horizontal curve and super elevation.
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Experiment No.9

Name Creating structural model and analysis of high rise structures [L1,L2]
Objectives e To understa_nd creating structural model and analysis of high rise
structures using staad pro.
Experiment No.10
Name Creating a model of building and the effect of earth quake [L1,L2]
—— e To understand creating structural model of building and effect of
Objectives .
earthquake using staad pro.
Experiment No.11
Name Create a model of large span roof and analyse [L1,L2 ]
I e To understand creating structural model of large span roof and its
Objectives A .
analysis using staad pro.
Experiment No.12
Name Crate a plan and set of structural drawings for a multi-storied building [L1,L2 ]
I e To understand and to create a plan of structural drawings for multi
Objectives

storied building using staad pro.
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Structural Analysis Using STAAD

Introduction to STAAD pro: It is a structural analysis and design computer program
originally developed by Research Engineers International at Yorba Linda, California in 1997. In
late 2005, Research Engineers International was bought by Bentley Systems

The commercial version, STAAD.Pro, is one of the most widely used structural analysis
and design software products worldwide. It supports several steel, concrete and timber design
codes.

Experiment No. : 1

Analysis of plane trusses:

1. (a) Analyze the given truss using STAAD pro software.

10kN
A 8
x ~* SkN
g
o
b A D
/

- Sen -

Problem study: The give truss have 5m span between two support and height is 5m. Two
forces (vertical and horizontal forces) are acting at point B.

Aim: To find the reactions at the supports and draw the bending moment, shear force and axial
forces in diagram using STAAD pro.

Tools Required: STAAD Pro Software, Microsoft Word Software, Paint Software, and
Printer.

Procedure:

1. Open STAAD software.

2. A new project is started with unit’s m & KN and structure type as Plane.

3. The given structure is drawn in the workspace using the graphical user interface of the
software according to given dimensions.
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4. Define the material property as steel, assign defined property to drawn truss using
commands.

5. Define Supports and assign to specified nodes of the structure.

6. Define load as nodal load and assign to specified nodes in trusses member by using
node cursor.

7. Perform analysis command was given.

8. The file was saved and run analysis command was executed.

9. Itis made sure that there is no error is indicated in the output window.
10. Post processing mode was selected.

11. The results were properly arranged using the tools.

12. Printouts were taken.

Results:
1. Reaction at support A =

2. Reaction at support B =
3. Shear force, bending moment and member force diagrams are attached.

Step-by-step operation on software:

Step: 1 Open STAAD pro software and set units.
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Start with new project > select space option in new model window > Type file name >
choose storage location > set units to meter and kilo newton.

Step: 2 Choose add beams option.

bwbdtqwneddha-&qr—pnnvdh.-mﬁmﬂ
drowrg tooks 3 soreadntenty

<bor [ P | | Carcs e

Choose add beam options to draw model.

Step: 3 Open STAAD pro to make model by using snap node or beam option.
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The above figure shows that the truss drawn according to given question. If you want to
increase grid spacing use edit command.

Step: 4 Defining of material and assign material to truss.
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Go to General > property > section database > select Indian angle > assign by using assign to
view option

Step: 5 Create support condition and assign to nodes.
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Go to support > create support as pinned (MX, MY, MZ are released), and roller support (FX,
FZ, MX, MY, MZ are released) by considering fixed but option > assign support to model by
using node cursor and assign to selected node option.

Step: 6 Define load case and assign load cases.
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Go to loads and definition > Click on load case details add load casel > Click on load case 1
add nodal load as FY=-10kN, FX=5kN add > select defined loads and assign to truss.

Step: 7 Analysis/print.
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) N Pee ++ Bead Oheck Data 1n Load Casms 103662
++ Usirg [r<Cote Adwsaced Mtk Solves
() loed Data + Processing sod setting up load Yector 1D 3552
5 ++ Processing Elemsas Stiftsess Matrix 10:3% %
R D ++ Caloulatitg Meaber Fosces 10.3% .5
v ++ Asalysie Soccesefully Copleted
(O %mcs Load + Creetina Displocessnt File (IGF) 6.3 5
Y Mode 3 +¢ Creeting Pesctium File (SEA 10:3% .5
: o Caloulating Sectim Furcesi-tll 10355
(5 Bt 4+ Caleulating Section Farcesl 18:35.5
++ Cruating Secticn Force File (BED) 10:36:5
N ++ Cruating Secticn Displace File (SO§) 16:35:52
++ [Lone b2 52
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G \STAAD FROMCL anl -
) »
T Dt e
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Go to analysis/print > select all add > go to analyze > run analysis > If no error found go to
post processing mode.
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Step: 8 Results.
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In post processing mode > go to reactions to get support reactions ( in this problem the
support reaction is -5 , -5 at fixed support and 15 at pinned support ).

(T S -
. T —— -
[
- A W

R o TR .

Axial force diagram Shear force diagram
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—

N R e

Bending moment diagram

Step: 8 Report extraction.
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In Post processing mode go to report > select input and output parameters should be
extracted > ok > go to file > export report > MS WORD.

Reactions
Horizontal Vertical Horizontal Moment
Node L/C FX (kN) FY (kN) FZ (kN) MX (kNm) | MY (kNm) MZ(kNm)
1 1:LOAD CASE 1 -5.000 -5.000 0.000 0.000 0.000 0.000
2 1:LOAD CASE 1 0.000 15.000 0.000 0.000 0.000 0.000

Beam Maximum Shear Forces

Distances to maxima are given from beam end A.

Lengt Max
Bea | Node h d 2 d Max Fy
m A L/C
m m kN
- M | ey | @ (kN)
1 1 5,000 | 1:LOAD Max 0.000
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Max -ve 0.000 -0.000

2 2 5.000 | 1:LOAD Max 0.000 0.000
Max -ve 0.000

3 3 5.000 | 1:LOAD Max 0.000 0.000
Max -ve 0.000

4 4 5.000 | 1:LOAD Max 0.000 0.000
Max -ve 0.000

5 1 7.071 | 1.LOAD Max 0.000 0.000
Max -ve 0.000

6 4 7.071 | 1:.LOAD Max 0.000
Max -ve 0.000 -0.000

Beam Maximum Axial Forces

Distances to maxima are given from beam end A.

Length d Max Fx
Beam Node A L/C
(m) (m) (kN)
1 1 5.000 | 1:LOAD CASE 1 Max +ve
Max -ve 0.000 -3.018
2 2 5.000 | 1:LOADCASE 1 Max +ve 0.000 11.982
Max -ve
3 3 5.000 | 1:LOAD CASE 1 Max +ve
Max -ve 0.000 -3.018
4 4 5.000 | 1:LOAD CASE 1 Max +ve
Max -ve 0.000 -3.018
5 1 7.071 | 1:LOAD CASE 1 Max +ve
Max -ve 0.000 -2.803
6 4 7.071 | 1:LOADCASE 1 Max +ve 0.000 4.268
Max -ve

Beam Maximum Moments

Distances to maxima are given from beam end A.

Length d Max My d Max Mz
Beam Node A L/C
(m) (m) (kNm) (m) (kNm)
1 1 5.000 | 1:LOADCASE1l | Max +ve 0.000 0.000 5.000 0.000
Max -ve 0.000 0.000 0.000 -0.000
2 2 5.000 | 1:LOADCASE1 | Max +ve 0.000 0.000 0.000 0.000
Max -ve 0.000 0.000 5.000 -0.000
3 3 5.000 | 1:LOADCASE1l | Max +ve 0.000 0.000 0.000 0.000
Max -ve 0.000 0.000 5.000 -0.000
4 4 5.000 | 1:LOADCASE1 | Max +ve 0.000 0.000 0.000 0.000
Max -ve 0.000 0.000 5.000 -0.000
5 1 7.071 | 1:LOADCASE1 | Max +ve 0.000 0.000 0.000 0.000
Max -ve 0.000 0.000 7.071 -0.000
6 4 7.071 | 1:LOADCASE1l | Max +ve 0.000 0.000 7.071 0.000
Max -ve 0.000 0.000 0.000 -0.000
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Beams
Length _
Beam Node A Node B Property
(m) (degrees)
1 1 2 5.000 1 0
2 2 3 5.000 1 0
3 3 Z 5.000 1 0
7 7 1 5.000 1 0
5 1 3 7.071 1 0
6 4 2 7.071 1 0
Materials
E Density _
Mat Name -
(KN/mm?) (kg/m?) (°C)
3 STEEL 205.000 0.300 7.83E3 12E-6
4 STAINLESSSTEEL 197.930 0.300 7.83E3 18E -6
5 ALUMINUM 68.948 0.330 2.71E3 23E -6
6 CONCRETE 21.718 0.170 24E3 10E -6
(b) Analyze the given truss using STAAD pro software.
35 kN 45 kN 35kN
48m
b ol 48m 48m _,  48m
1 Y2 Y3 Ya
5
A E|l e
©
|
Rsy @y -
Rqy 6 8
7
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82 47 82 AT

Forces in members obtained from manual calculation.
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Support reactions obtained in software is matching with manual calculations.
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A BI52ARN + 7.134 kN
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Forces in members obtained from software.
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Bending moment diagram with graphs
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VIE truss1 - Whole Structure &=
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Shear force diagram.
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Examples to solve.

1.
18N 18N
A Cl El G i
3m
B J
L dm g, dm g dm g dm
" o Ky ™ bl “
2.
3.
I5 kN 10 kM 15 kN
H L ] G 1rF E

A D
;;;;;; B C prAS
, 20 kN

KLS VDIT, Department of Civil Engineering



Software Application Lab BCVL606

1(b) Analysis of Continues Beam

Analysis of a Fixed Beam Using STAAD pro software.

21 kN
/] 3 kN/m .
A;m’;mﬁ\f_\ B B

Aim: To find the reactions at the supports and draw the bending moment and shear force
diagram using STAAD.

Tools Required: STAAD Pro Software, Microsoft Word Software, Paint Software, Printer

Procedure:
1) Open STAAD pro software.

2) Start with new project set unit’s to m & KN and structure type as Plane.

3) The given structure is drawn in the workspace using the graphical user interface of the
software.

4) Define section property as rectangular assume suitable dimension assigned to the members
drawn by using assign to view option.

5) Create support condition as fixed assign to the beam at required nodes.

6) Define load cases in a single load case, as concentrated force of 21kn and uniform force of
3kn/m and assign on beam member.

7) Perform analysis command was given, the file was saved and run analysis command was
executed.

8) It is made sure that there is no error is indicated in the output window.

9) Post processing mode was selected.
10) The results were properly arranged using the tools.
11) Printouts were taken.

Results:
1. Reaction at support A =

2. Reaction at support B =
3. Shear force and bending moment diagrams are attached.
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(b) Analysis of a Propped Cantilever Beam Using STAAD

EI 5 kN/m
A 4.0 -j

A I—- 2.0 —=

B

Aim: To find the reactions at the supports and draw the bending moment and shear force
diagram using STAAD.

9 kN

Tools Required: STAAD Pro Software, Microsoft Word Software, Paint Software, Printer

Procedure:
1) Open STAAD pro software.

2) Start with new project set unit’s to m & KN and structure type as Plane.

3) The given structure is drawn in the workspace using the graphical user interface of the
software.

4) Define section property as rectangular assume suitable dimension assigned to the
members drawn by using assign to view option.

5) Create support condition as fixed and simply supported assign to the beam at required
nodes.

6) Define load cases in a single load case, as concentrated force of 9kn at 6m distance and
uniform force of 5kn/m and assign on beam member.

7) Perform analysis command was given, the file was saved and run analysis command
was executed.

8) It is made sure that there is no error is indicated in the output window.

9) Post processing mode was selected.

10) The results were properly arranged using the tools.

11) Printouts were taken.

Results:

1. Reaction at support A =
2. Reaction at support B =
3. Shear force and bending moment diagrams are attached.
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(c) Analysis of a Continuous Beam Using STAAD

9 kN
5 kN/m l
A Y N e A T N Y Y Y Y
4.0 T 2.0 ~! 2.0 A 2.0 A
B C D

Aim: To find the reactions at the supports and draw the bending moment and shear force
diagram using STAAD.

Tools Required: STAAD Pro Software, Microsoft Word Software, Paint Software, Printer

Procedure:
1) Open STAAD pro software.

2) Start with new project set unit’s to m & KN and structure type as Plane.

3) The given structure is drawn in the workspace using the graphical user interface of the
software.

4) Define section property as rectangular assume suitable dimension assigned to the
members drawn by using assign to view option.

5) Create support condition as fixed and simply supported assign to the beam at required
nodes.

6) Define load cases in a single load case, as concentrated force of 9kn at 6m distance and
uniform force of 5kn/m and assign on beam member.

7) Perform analysis command was given, the file was saved and run analysis command
was executed.

8) It is made sure that there is no error is indicated in the output window.

9) Post processing mode was selected.

10) The results were properly arranged using the tools.

11) Printouts were taken.

Results:
1. Reaction at SUPPOrt A = .....ccccvvereneneneneniens :

B= :

Coe :

D=

Shear force and bending moment diagrams are attached.

ok~ wn
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d) Analysis of a Continuous Beam Using STAAD

15 kN 8 kN
4 kN/m i
RS ——_
1.5 1.5 2.0 1.0 1.0
B C D

Aim: To find the reactions at the supports and draw the bending moment and shear force
diagram using STAAD.

Tools Required: STAAD Pro Software, Microsoft Word Software, Paint Software, Printer

Procedure:
1) Open STAAD pro software.

2) Start with new project set unit’s to m & KN and structure type as Plane.

3) The given structure is drawn in the workspace using the graphical user interface of the
software.

4) Define section property as rectangular assume suitable dimension assigned to the
members drawn by using assign to view option.

5) Create support condition as fixed and simply supported assign to the beam at required
nodes.

6) Define load cases in a single load case, as concentrated force of 9kn at 6m distance and
uniform force of 5kn/m and assign on beam member.

7) Perform analysis command was given, the file was saved and run analysis command
was executed.

8) It is made sure that there is no error is indicated in the output window.

9) Post processing mode was selected.

10) The results were properly arranged using the tools.

11) Printouts were taken.

Results:
1. Reaction at SUPPOIt A = ....coveiiiiiieiie e ,

B=

w
O
I

D=
Shear force and bending moment diagrams are attache

AN ol
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C 5kN

5 kNm

D
(a) Free-bodies 10 kN 5kN 2m 5kN
SkN
< I 77
I 10
A (tension) B 10 kN =
D
B p—e
C TTITIITITTTIITR - 3 kN A =KL
c D

(b) Axial force diagram

""""""" (due to vertical
load alone)

(d) Bending moment diagr.am  JyTtcccoooo-

10 kN
(e) Deflection diaarams
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EXPERIMENT 2
Analysis of portal frames using software

2(a) Analysis of a Single storied 2D Portal Frame Using STAAD

Aim: To find the reactions at the supports and draw the 5 kN

bending moment and shear force diagram using
STAAD. '

Tools Required: STAAD Pro Software, Microsoft
Word Software, Paint Software, Printer

Procedure: 20 kN

1.
2.

o o

2.0 2.0

Open STAAD Pro software.

Start with new project set unit’s to m & KN and
structure type as Plane. 3.0
The given structure is drawn in the workspace
using the graphical user interface of the
software.

Define section property as rectangular concrete
section with suitable dimensions assumed..

Create Supports as fixed and assign to required node.
Loading is defined in a single load case and concentrated force of 5kn and 20kn assign
to the frame at suitable distance.

Perform analysis command was given

Post analysis print options were selected suitably.

The file was saved and run analysis command was executed.

. It is made sure that there is no error is indicated in the output window.
. Post processing mode was selected.

. The results were properly arranged using the tools.

. Printouts were taken.

Results:

1.
2.
3.

Reaction at support A =
Reaction at support D
Shear force and bending moment diagrams are attached.
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(b) Analysis of a Double storied 2D Portal Frame Using STAAD

Aim: To find the reactions at the supports and draw -
the bending moment and shear force diagram using ~ _ " b
STAAD. 8 kN =
Tools Required: STAAD Pro Software, Microsoft
Word Software, Paint Software, Printer i i
Procedure:
1. Open STAAD Pro software.
2. Start with new project set unit’s to m & KN
and structure type as Plane. 12 kN - E
3. The given structure is drawn in the G 40
workspace using the graphical user interface
of the software.
4. Define section property as rectangular
concrete section with suitable dimensions = =
assumed.
5. Create Supports as fixed and assign to
required node. A F
6. Loading is defined in a single load case and e e

concentrated force of 6kn and 12kn assign to
the frame at suitable distance.
7. Perform analysis command was given
8. Post analysis print options were selected suitably.
9. The file was saved and run analysis command was executed.
10. It is made sure that there is no error is indicated in the output window.
11. Post processing mode was selected.
12. The results were properly arranged using the tools.
13. Printouts were taken.

Results:
1. Reaction at support A =

2. Reaction at support F =
3. Shear force and bending moment diagrams are attached.
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Project Management Software
Experiment 3,4,5.6

Understanding basic features of Project management software.

1. PLANNING AND SCHEDULING

2. COLLABORATION.

3. DOCUMENTATION

4. REPORTING

5. RESOURCE MANAGEMENT

6. MANAGING THE PROJECT BUDGET SUMMING IT UP

What is a project?

Project is a temporary effort undertaken to create a unique product or a new service. It might take
one week, months or many years but must have some finish date.
Must Remember:

1.Project manager must have complete knowledge of product (product specifications) to be
developed before defining the scope (cost, time, resources) of the project.

2. A good Manager is one who completes the project intime, within budget and as per customer
satisfaction.

Why to use MS Project? MS Project helps to track the information about project goals cost
deadlines and resources.

SOME OF THE IMPORTANT VIEWS IN MS PROJECT:

>

Gantt chart view is a default view gives information about tasks, duration of each task,
starting and finishing dates and resources allocated to that specific task.

Resource sheet view elaborates all available resources allocated to a project in a sheet
format. It doesn’t tell which tasks are assigned to which resource.

Resource Usage view groups the tasks against each resource.

Task usage view shows details about each task that which task is assigned to whom and
working schedule of each resource.

Calendar view Task bars appear on the days are scheduled to start.

Network Diagram view shows relationship among tasks and also dependencies.
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CALENDAR

AIM: To create a new base calendar that has 6 working days per week and 10 hours between. The
calendar should include holidays on the third Saturday of the month. Assign the new base calendar

as project calendar.

PROCEDURE:

1. Go to project menu > properties > change working time.

2. Click create new calendar.

3. If we want to begin with a default calendar, click create new base calendar.

4. Else you want to create a new calendar based on existing calendar, click
make a copy of and then click calendar name in the calendar bar.

5. In the “name box”, type your name of a new base calendar.

6. Click ok.

7. On the calendar, select the days You want to change.

8. Click the “detail” tab and set working time for the next working sheet. Click ok.

9

Now the “option” tab has to be clicked > calendar option for project set working time.

10. For editing calendar, refer “work weeks” and “exceptions”.
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Ok on 2 day % see 3 yorkng Smes;
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21 24 125 |26
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Non-working day
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AIM: - To construct a network diagram & critical path

TASK & ITS RELATIONSHIP

BCVL606

PROCEDURE:-
1. Click the task mode as auto schedule.
2. Enter the activities or task name in the task name column.
3. Enter the duration of each activities in the duration column.
4. Inthe entry table enter predecessor’s numbers in the predecessor column.
5. Right click on gantt chart & then click on show /hide bar styles.
6. Then press critical path.
:Task Task Name {Duration |Start Finish Predecessors
o v v v v -
| ‘Mode . , |
- = Start of project 0 days Wed 09-05-18 Wed 09-05-18
2 = Purchase site 3 days Wed 09-05-18 Fri11-05-18 1
3 2 Prepare blueprint 4 days Fri11l-05-18  Wed 16-05-18 1SS+2 days
4 = Excavation 5 days Mon 14-05-18 Fri18-05-18 2
3 b= Foundations and 4 days Thu 17-05-18 Tue 22-05-18 3
Basement walls
6 'TE'> Frame 3 days Wed 16-05-18 Fri18-05-18  4FS-3 days
7 = Electrical Wiring 4 days Wed 23-05-18 Mon 28-05-18 5,6
8 b= Insulate 3 days Tue 29-05-18 Thu31-05-18 7
9 S Roofing 5days Fri 25-05-18  Thu31-05-18 8SS-2days
10 = Ductwork and Plumbing 6 days Fri01-06-18  Fri08-06-18 9
11 = Install siding 5 days Mon 11-06-18 Fri15-06-18 10
12 = Exterior Painting 6 days Mon 18-06-18 Mon 25-06-18 11
13 > Interior Painting 3 days Tue 26-06-18 Thu 28-06-18 12
13 =t Carpeting 5 days Fri29-06-18  Thu05-07-18 13
15 S end of projects 1day Fri06-07-18  Fri06-07-18 14

Entering of Tasks
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BCVL606
| [ Apr'18 07 May '18 |21 May '18 04 Jun '18 |18 Jun'18 02 Jul '1i4
(WlsTT[MIFIT[s[w][s[T[MIFIT[s[w][s[T[M]EH:

Purchase sit
Prepare bluep

Electrical Wiring |
Insthate—

Roofing 4@
Ductwork and Plumbing
Install siding
Exterior Painting
Interior Painting
Carpeting :
end of projects
Gantt Chart
n [07 May "18 121 May 18 |04 1un 18 |18 Jun ia |02 Talas s

s [ T

M T F I T el wWwlselT | MTFT T STWIS[T I MI]FT

(i) v

Critical Path

RESOURCE DEFINING & ASSIGNING

AIM: - To define and assign the resource to complete the task in your project.

KLS VDIT, Department of Civil Engineering



Software Application Lab

There are three types of resources to be assigned
1. Work Resources.

2. Cost Resources.
3. Material Resources.
PROCEDURE:-DEFINING OF RESOURCES

1. Go to view bar and then select resource sheet.

BCVL606

2. In resource sheet enter the resources in the resource name column.

3. Mention the type of resources in the type column.

ASSIGNING OF RESOURCES

1. Inview bar select Gantt chart and double click on particular activities or task.

2. A dialog box will open then select resources.

3. Finally then add resources.

Example 1:-
ID Activities Duration Predecessor
1 Start 0 -
2 DPP 3 1
3 Land Acquisition & Requisition 5 2
4 Tender Document Preparation 7 3
5 Tender 9 4
6 Bid Evaluation 7 5
7 Tender Award 5 5
8 Procurement 4 6,7
9 Mobilization 3 8
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10 Clearing, Grading And Stringing 15 9

11 Trenching, Lowering And Back Filling 20 9,10
12 Hydrostatic Testing 4 11

13 Cleaning 3 12

14 Commissioning 4 13

15 Operation 6 14

16 End 0 15
ENTRYING OF RESOURCES

ID Resource Name Max. units Std. rate

1 Project Manager 2 400/day
2 Site Engineer 2 350/day
3 Surveyor 1 300/day
4 Workers 20 250/day
5 Equipment - 500/machine

ASSIGNING THE RESOURCES

TASK 1 |2|3|4|5]|6 718 [9 10 (11 |12 |13 |14 15 16
Project - 1)-1]11]1)- 1/- |1 |- 1 - - 1 1 -
manager

SE - 1/1(-]-]1 -1 |- 1 1 - - - 1 -
Surveyor - |- ]1/1]1]- 1/- 11 |- - 1 1 1 - -
Workers - 2/5|/-12,1 5 - 5 |9 5 5 18 |5 5 -
equipment |- |1 /3 /- - |5 9/5 |1 |- 1 5 6 2 3 -
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| o ?nk - Yotk N =" Mvcﬂ - iﬁ;-c = h’m:n. = ;na‘m
trode

S F " san Odis  Wed 020318 Wed 0n5-1n

3 - DPP 3 davs Wod 09-05-18 Fri13-0548 1

3 * Land Acquestion & S days Mon 14.05-18 Fri 180518 2
Recuinit

- = Tender Documnent 7 davs Mon 21.05-18 Tue 290518 3
Preparason

3 ! Tender 9 days Wed 20-05-18  Mon 13-06-18 4

o = Bid Evaluation 7 davs Tue 12.06-18 Wead 20-06-18 S

? = Tender Award S days Tue 12-06-18 Mon 12-06-18 5

" : Procurement 4 days Thi 21-06-18  Tue 26-06-18 6,7

3 k- Mobilization 3 davs Wed 27.06-18 Fri29-05-18 8

10 * Clearing. Geading And 15 days Mon02-07-18 Fri2007-18 9
Stninging

11 - Trenching, Lowermg And 20 davs Mon 23-07-18 Frii7-G8.18 3,10
Back Filing

3 ! Hydrostatic Testing 4 days MON 20-08-18  Thy 23-08-10 11

13 - Cleaning 3 days Fri24.08-18 Tue228.08.18 12

1e - Cemmissioreng 4 days Wed 25-08-18 Mon 03-09-18 13

1 b Operation 6 days Tue O4-09-18  Tue 11-09-18 14

1 - End 0 days Tue 11.09-18 Tue 110918 15

ol - .

Entry Table

s Surtoea- 5 B :7 i 3 g e -: |
= v - B - —= 0 —— =
S8, A depat Ve Mok | Bk _ e
Shedss 15 st
YihEZks vouwp YN Y SR YOtde Y sl v AceRY GselindarY
p 2T4000dy 0007 $0¢ Procated  Siandad
5 20350005y 000/ 3000 Proeated  Siasdard
5 15300003y I000h 000 Prorated  Standard
U] DTS00y 300 3006 Proraied  Stazdand
| 3 cguipmen Maerd  nos e 3000 000 Proeated

Resource Sheet
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Resources:

General | Predecessors Resources | Advanced | Notes | Custom Fields |

i Duration: ‘Bday;\—;—' || Estimated

BCVL606

| project engineer

|Resource Name IAssignment Owner Units Cost

= Jine 2.00 % 2,400.00
site engineer 2.00 % 2,100.00
workers 2.00 % 1,500.00

% 500.00

Assigning of Resource
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GIS applications using open source software

Experiment 7

What is a Geographic Information System (GIS)?

A Geographical Information System (GIS) is an organized collection of computer hardware,
software and data used to link, analyze and display geographically referenced information.

A Geograph i v (GIS) links & (sp ) and ( ) information and s
a person to visualize patterns, relath ps, and This process gives an entirely new perspective to data
analysis that cannot be seen in # table or list § The five P of » GIS are listod below.

The foundation of GIS is the ability to locate objects and events (streams, villages, disease cases) and
link them with appropriate information in order to identify patterns and provide a basis for map making
and analysis. Key types of geographical data, represented as separate map layers in a GIS, are outlined
in the table below.

Sr. | Data Type [Example Layer on Map
No v «1%&‘ 5.
1 | POINT Building, Hospital, oo . o B
City, Well. 0 = Cmy R
-
2 | LINE River, Road

-~

3 POLYGON |Administrative
Boundaries, Census
tacts.
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|4 | RASTER [Pixel or grid data

Vector data: A representation of the world using points, lines, and polygons. Vector models are useful
for storing data that has discrete boundaries, such as country borders, land parcels, and streets.

Point features: A map feature that has neither length nor area at a given scale, such as a city on a world
map or a building on a city map.

Line features: A map feature that has length but not area at a given scale, such as a river on a world
map or a street on a city map.

Polygon features: A map feature that bounds an area at a given scale, such as a country on a world
map or a district on a city map.

Raster data. A representation of the world as a surface divided into a regular grid of cells. Raster
models are useful for storing data that varies continuously, as in an aerial photograph, a satellite image,
a surface of chemical concentrations, or an elevation surface.

With a GIS application you can open digital maps on your computer, create new spatial information to

add to a map, create printed maps customised to your needs and perform spatial analysis.
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Understanding QGis
What is Quantum GIS?
Quantum GIS (QGIS) is a user friendly Open Source GIS application licensed under the GNU General

Public License. QGIS is an official project of the Open Source Geospatial Foundation (OSGeo). It runs
on Linux, Unix, Mac OSX, Windows and Android and supports numerous vector, raster, and database
formats and functionalities.
Like all GIS applications, QGIS provides a graphical user interface allowing display of map layers and
manipulation of data for analyses and map-making.
A Geographical Information System (GIS) is a collection of software that allows you to create,
visualize, query and analyze geospatial data. Geospatial data refers to information about the geographic
location of an entity. This often involves the use of a geographic coordinate, like a latitude or longitude
value. Spatial data is another commonly used term, as are: geographic data, GIS data, map data,
location data, coordinate data and spatial geometry data. Applications using geospatial data perform a
variety of functions. Map production is the most easily understood function of geospatial applications.
Mapping programs take geospatial data and render it in a form that is viewable, usually on a computer
screen or printed page. Applications can present static maps(a simple image) or dynamic maps that are
customized by the person viewing the map through a desktop program or a web page.
Many people mistakenly assume that geospatial applications just produce maps, but geospatial data
analysis is another primary function of geospatial applications. Some typical types of analysis include
computing:

1. Distances between geographic locations

2. The amount of area (e.g., square meters) within a certain geographic region

3. What geographic features overlap other features?

4. The amount of overlap between features

5. The number of locations within a certain distance of another

6. and so on...

These may seem simplistic, but can be applied in all sorts of ways across many disciplines. The results

of analysis may be shown on a map, but are often tabulated into a report to support management
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decisions. The recent phenomena of location-based services promises to introduce all sorts of other
features, but many will be based on a combination of maps and analysis. For example, you have a cell
phone that tracks your geographic location. If you have the right software, your phone can tell you what
kinds of restaurants are within walking distance. While this is a novel application of geospatial

technology, it is essentially doing geospatial data analysis and listing the results for you.

System Requirements

Windows OS:

Minimum: Pentium I11 / 256 MB RAM.
Recommended: 1 GB of RAM and 1.6 GHz processor.

Operation System: Platforms Windows and Linux (Win XP or newer, Linux Suse 8.2/9.0/9.2, Linux
Debian (Lliurex))

MAC OS:

PC/Desktop with at least Pentium IV

Tiger OS, Leopard OS.
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PRACTICAL - 1

AIM : - Creating and Managing Vector Data:
a) Adding vector layer
b) Setting properties
c) Vector Layer Formatting

Procedure:

a. Adding vector layers (Polygon, Line, Points)

» Polygon layers (We have taken 2 layers Matunga, Garden)

» Line layers (We have taken 3 layers Small_Roads, Road, Flyover)

» Point layers (We have taken 4 layers bank,college,Restaurants, ATM)
b. Setting properties (Labeling, Symbolism)

Layers g X
{(Im 'TT E“"'_Etv_;#ﬂ

® bank

1 college

1Y Restaurants

2 ATM

= S5mall_Roads

— Road

Flyowver

| Garden i

Matunga

Our aim is to create map representing a location and its surrounding as
follows:

KLS VDIT, Department of Civil Engineering




Software Application Lab BCVL606

a. Creating Polygon vector layer
» Select Project->New

Settings

Plugins Vector Raster Database
Data Source Manager

Web MMQS Processing Help
CtrieL DO Q Qe é &
5™ New GeoP = ‘

5 Ctrl+Shift+ N
[ [[V5  New Shapefile Layer...

Create Layer
Add Layer

Embed Layers and Groups... /7 New Spatialite Layer...
Add from Layer Definition File... @9 New Temporary Scratch Layer...

R PSSR R T SV AR

> Following dialog box will appear on the screen. Select Polygon option from Geometry type.

G P Srapertie Lapwr x
"

et |

Gy T

W P
-
Tupe e Tout dete

e —

» Fill the appropriate information in each text box.
e Filename:

By default the file will be saved in bin folder.
To avoid it click on following button to change the location of file.

PR — -
iy = D[

- et

e N [

........

...............
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Q
Pl e '«-uua a
Fie encotng Srteny
Geometry tipe Pohgon
] inchuce 7 dmension U] tnchade M vohies
G Seva Layer As X
New §icid
1 Desitop » Pisctical 1 v & esrh Practics R
Nars
Tame | lovcTen dote Osganie New Toldes oo o
I
Lergth a0 L R
P 30 Otjects
Pk List -
3 Documents
Parse Type $ Downloads Matunge shp
] Int
! - D Musc
& Poture
B vieeon
- Windows ()
P Netoork 5
File nayme F- v n-:
Sove 0t ype 5N Shapetie ["ahp " 99
i ~ Hide Folders Cancel
T
o Concsd L

> Field Panel
» Add the Attribute you want to show. (Column Name for Table)

b. Specify Type (DataType:Text Data/Decimal Data/Whole Number/Date) of Attribute
c. Specify the Length of the Attribute. Specify Precision (If Data Type is Decimal)

G2 New Shapefile Layer >
roe rme faga -l
File encodng System
Geomelry type L Polygon ~
) inchude 7 denension [ inchude M valses
lP'-G:‘!n - WGS 804 - >
New Hield
Name  |Marme |
Type | absTaxt data -
Length 00 1 Precson
7 Add to Peida Lt @
Name Type Length Predaon \
W Integer 10
|

» Click on Add to Field List Button.
» You can add as many fields (Column Name) as you want for the layer.
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G2 Naw Shapefile Layer "
Fibe rusme [Matunga a |
File ancodng System ~
Geaomeatry type L Polygon ™
[ indude Z denension ] Inchude M volies
TREGRIE _Weses =L
HMew Field
Home luame I
Tyee b Toext data ~
tength (80 Precsion
£ Add 1o Fieichs Lint @
Narne Type Length Preason
] Integes 10
Click on the following button

e T —

[ ye— e

o e iter "rutomy
7 e

[ e P ——"

PEOGARINR  WaGh e

Cmermtimn ey ryom

Sha e ¢ aer bt
L (Yo

T e Twad et

Lty (00 [
(10 ket s $iminbe | it
b thas
T Ty [p— Pa—
0

L [

R ]
"~ d

L= et e

» The CRS dialog box will appear on screen. Click on the WGS84 option and it will be selected

as follows. click on OK

‘ (2 Coodinste Reference Systmm Sefector

| ¢
Define 1t IVErs « wdinats

wlers

-

THIL LAyt SREAars £ Rave NG PISjeion (pectication, By defat, the Layer will now have its Progertion oot 1o et

Of 1 BU0Ject, DUL yu By OverTide T by selecting & GYerent Propection below

P

st wele

| Coocdinate Refersnce System Authonty 10

WGs a4 EPSGAR20

Coordinate Reference System Aahooty 1O
WGS €6 EPSG4TS0
WGE 77 PPSGAL2
WGS T28E EPSGA34 |
was 4 B s |

Selocted CRS  AGS 34
Extant: -180.00, 9000, 180.00, 90 00
Projé: 4proj=hrgiat detum =\WGES34 4o _dets

TH

l =

Carewt el
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a) Follow the steps to plot Polygon features.
» Select the Polygon Feature( In our case it is Matunga for background) from layer panel

Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
BRHTese »RPP LALLM
VA ] 7 B3 %~ M ¢ & B p|:@
» Click Toggle Editing Button - Click on Add Polygon ->Now place the cursor
at the location where you want to place the polygon. for polygon layer minimum 3 points
should be selected

-

. - - “r» .
eV e » - - a~*sn

.....

> Save the newly added polygon as follows.

Matunga - Feature Attributes n
Actions
d 1 a |
Name |Mathga a |
Cance

» Set style for polygon by using property window(Right click on Matunga Layer)
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28T * O

Favorites
» ¥ Prcject Home
= Home
» O S
o GecPackage
77 Sparialite o
W postGis (o
B passar
@ Cracie
= os2
@ WNMSAWMTS
v B XYZ Tikes
& wcs
AT WFS
o> ows
& ArcGisMapSery.
&7 ArcGisFeatureS.

7‘.7_7 >
o M e TV 5,

-
-
o>
s

VI8 |

! Zooen to Layer

Koo to Selection
Show in Overview
Show Feature Count
Ceopy Layer

Repame Layer
Duplicate Layer
Berrove Layer....
Dpen Artrnibute Table

Set Layer Scale Viesibality .
Se2 CRS >

- 2 satungas

» Following screen will appear on the screen. Select pattern as you want and click on OK.

| @ Lopts Prrpwte Mitswge | Sy
B e vyt

pmiv

b

» Same way we can add one more p

oaw @ 3

7] N

Sadea bns

oo,
.
voed

e

el bk e bk X betae bie

e b

A A I ==

[B] cmm | wm

olygon layer for Gardens.

BCVL606

W

HRO R

O @ 5 5= 20 3350 5 5 it ) B8

e 08-S

S mEeIs-.

BV e pTIEMR-2 0 - S SRR R Bl B
R - x

oY e

&

+

el B R

e+ @

et

Fhoe B @

- et Bt 3 o Wl

P e .

KLS VDIT, Department of Civil Engineering

> —

39



Software Application Lab BCVL606

a) Creating Line vector layer

> Repeat the same steps as we have done for polygon layer.
» Select geometry type Line.

G} New Shapefile Layer

b
File nane |Rosd a |
File ancodng Syntmn ~ |
Geamatry type Lirve -~ I
[T TRde 2 Gerarvmon T o vakies
vl projec tion =l -
Hew ekl
Name [Hame_ ]
Tvpe whs Tent date ~
Length |80 Preceon
L Add 1o Pty Lint
Fields List
Feame Typw Langth Precmon
" Integer 0

> Road layer :
» To plot road click on Add Line Feature.

R@V.Zw p7BGf-2T <8 B 6 o

» Click on the map where you want to draw line.

M 87| O e & 2 50 FJ 00 O (g 4g g BB 10 &) & & -
w2 NEYE -2 T » .

@ e @ @ e, = Tt e - T
& x

-~

ver

[ S e
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PR Venten  Mosios - Dlstateoss Wesh Pemsssing  olw
S LR e B TR T B ED 28 SOV e o - -
L A Al F - - - .- - Y
& =l
- -

» save your data

Foad - Feature Attributes Hl
HAuctions i
id |1 |
Mame |Mat|..|r1ga FPool |
I OK I | Cancel

> set style for Roads in the same way as we have done for polygon

Browser C
.
CL &Y it & Zoom to Layer
- :t 5 Zoom to Selection
avarites
oy
[ Project Hame o Show in Overview
(@] Home Show Feature Count
[ en Copy Layer
@ GeoPackage Rename Layer
A Spatialite I Duplicate Layar
W PostGIs A R L
"= Mssal emove Layer.
@@ Oracle [ Open Attribute Table
m Ll . Togyle Editing
o WMS/WMTS b4 Save Layer Edits
W XVZ Tiles & Current Edits »
@ wes g
Filver
VD WES
L0 QWS Set Layer Scale Visibility, .
@ ArcGisMapServer Set CRS [4
W ArcGisFeatureSer
= Export »
Layers
- Styles >
Properties.
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G Lager Propesties - Rosd | Syovbaloyy
B snge rrd
v Lee
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pateen circles  uimplebhistine  Bmgle geen line  wmple ed ke fope man foad

topo by
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> Road will look as below

e T L

U QoA PRI P EERNG x *E=-y -
’ s A . 1o B 0 e e BBk, SR |
.- - - - ) - ”77/;/'“ -

"}4‘
1
/4
'y
4
7/
//
) ; /:'/‘
1/
| /4
1/
//
1/
/4
/i
Vi
/

KLS VDIT, Department of Civil Engineering

BCVL606



Software Application Lab BCVL606

To label your roads Right click on Road layer .Go to properties window then select label and set
single label property

L Layer Propertes - Digiize fosd | Labe

» Following window will appear on the screen

. G Layer Properses - fload | Labels x|
= Srghe ek v &
Label with | wac e - [&
¥ Text Sawple
[ "
v
lizeere uam | #] rmeons - | Wy v
‘.u Text Text
T Farmeting Sont e Sl Dl 2 v &
e Guffe
w. Background o
| J Sedcor g &5 6 B = A =2
‘0:0 Plarwment Soe .0000 TR=4
J Remdening ==
Pt v 5
N - <
Opady Boes =&
oo cme Mo charge - (:g
Speng et ‘ 0000 I E="
wond 16,0000 =5
i recce  Norme v 5
] Aoy lnbed bmxt mbatitines
e - e e ] e
> Roads will look like these
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» To merge roads
e Go to properties of road then select symbology. Click on Advanced button select
Symbol levels.

Q Lo st - fund | Yyvboing
B wen sees
q - R
[
|
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» Click ok & Road will appear as follows

[ S——
ArEIAR, P asRBra es AT BT =
Shd B s, 5= e B b 5 B 05NN

I

C. Create Point vector layer

» Repeat same steps to add point layers as we have done in previous layers.(For ATM,
Restaurants, Banks, Bus Stops etc)

Nertgr Dester  Duiwhas  fee Pogseeey by

RIR S SN2 i BN S 0w -5 0 - m iR
BRSO ~qaNYEesestT R 42N
:—- v b B " o
o o S " o, e
g
lz“ S .."—
a
" . & e
.
e
—— 2 L
ki
J
Tl
Final output:
L L

JSY2e

173 v
B Fut e
" e
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BCVL606
d) Calculating line lengths and statistics
» Goto Layer > Add Layer - Add Vector Layer
» Add the following file to project
FaDataSourceManager[Vectof - 2 - e e | = |
h Browser Source Type
‘ml ) Directory () Database () Protocol: HTTP(S), doud, etc.
S/
* Raster Encoding [UTF-B ']
Etor Dataset(s) rkshop\Practicals\Practical_01\D\DATA\IND _rrd\IND _rails.shp €1 Q
Delimited Text
"\GIS_Workshop\Practicals\Practical 01\D\DATA\ND _rrd\IND _rails.shp™
Press “ADD”
» Also add India Administrative Map
“GIS_Workshop\Practicals\Practical_01\D\DATAVND_adm\IND adm0.shp”
» Double Click on IND_admO
Layers g X
AR & 3 2w
3 IND adm0 & symbology
IND_rails I

Select —> Select any outline style from below given options.

] L

outline black cutline blue

outline green

m

vvvvvvvv

+++++++++++++++++++++
++++++++++++
+++++++++++++++++++++
++++++++++++

+++++++++++++++++++++

-

[Sa'u.re Symbaol ] [Advanced "’]

ok J[ cancel || ey |[ Heb |
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Press OK
» The display window will appear like

Layers F X

o« Ml ® T &~ i O

— !

i IND rails =
}:-' Zoom to Layer

oo

]

Zoom to Selection
Show in Overview
Show Feature Count
Copy Layer

Rename Layer

Duplicate Layer

HB

Remove Layer...

Move to Top

Open Attribute Table I
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> Press Toggle Editing button using button, on Attribute table window toolbar.

» Press Open Field Calculator using button.
» Set the output field as “Track Len”, field type to “Decimal Number”.

Create a new field

[ create virtual field
Output field name |Trad<._Len I

Output field type [Decimal number {real) -

4|k

Output field length 10 |5 Predsion 2
Expression Function Editor |

» From Function List search $length or go to Geometry - Select $length

HEOUEEWYNW
|

row_number
= Aggregates
[ Arrays
[ Color
[ Conditionals

[ Conversions

[= Date and Time
[ Fields and Yalues
I+ Fuzzy Matching
I _General
l= Geometry
I hap Layers

[+ Maps

[= Math

I» Operators

[ Rasters

> Record and Attributes
l= 5tring

[* Wariables

[ Recent (fieldcalc)

Qutput preview:
» Set expression as

HHEUUEHEWEL MW

slength /1000
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Press “OK”
> A new column is added to the attribute table with value representing the length of track in KM.

3 . Tot 12 Filtered: 2012 Selected:
Dz 8 < 3 B & AT BRBRE & 88
[s22FD 180 d - ~|=[E]

ADraild  F.CODEDES  EXSDESCRE  FCODESCRI  FID_countr 50 ISOCOUNTRY | Track Len
1 ’ 14464;‘15 Raslrcad Operational Single 102 IND INDIA 2901
2 145891 Raslroad Operational Single 102 IND INDIA 6613
3 145001 Railroad Operational Single 102 IND INDEA 233
4 146008 Railroad Operaticnal Single 102 IND INDIA 63381
5 146096 Raslroad Operational Single 102 IND INDIA 9271
6 145394 Railroad Operational Single 102 IND INDIA 2224

- 1]
|123FD raild v |=
» Press CTRL+S or click on Save Edits option on tool bar
» Close the attribute table window.
» For calculating the total length of Railway tracks in India.
» Select Vector-> Analysis Tools—> Basic Statics for Fields

Project Edit View Layer Settings

Plugins Raster Database Web MMQGIS Processing Help

D = . 'El-‘_ :g @]E: :!- Coordinate Capture a Jenl H_j W 3 q?& c
. | ¥ Check Geometries...
Q@ /? e ,[—J ¥ @ GpsTools h e =Y E "’0 z
q i ’i ®  Topology Checker
Geoprocessing Tools 4

LEayen i Geometry Tools | A\
CA®TE-FAL I Analysis Tools 4 Line Intersections...

‘@ D IND_adm0 Data Management Tools ~ » | £ Mean Coordinate(s)...

[l IND vails Research Tools » | 2 Basic Statistics for Fields...

» Select IND_rails layer from input layer. And select Track_Len in “Field to Calculate statistics

2

on
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Parameters Log

Input layer

[fm_rais [EPSG:4326] v] ]
|| Selected features only
Field to calculate statistics on )

[ 1.2 Track_Len il ]
S

Statistics

| I:/GIS_Workshop/Practicals/Practical_01/D/Output. html @

> Press RUN

» The Result is

Aexdtar
{'CoONY = 2011,
OV 1 FLaINLOYENTIDeRN,

CMEAN' 30, 060B4LTEREIA0E

TMEDTAN® . 14.04,

MWL 0.8,

MINCRITEC. D.03,

COTTFUT_MTWE_FILE ' S /Ummrs/Anks teshs Zoptene
Lozal/Teep/

» - —azwT tagerras
209236l fcillTIdIcCanibdu I T/ -
" o
R e B Procems..| -
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» Open the “output.html” file to get the field statistics.
Analyzed field: Track_Len
Count: 2012
Unique values: 1608
NULL (missing) values: 0
Minimum value: 0.0
Maximum value: 400.48
Range: 400.48
Sum: 60479.320000000014
Mean value: 30.059304174950306
Median value: 14.04
Standard deviation: 39.483220276624444
Coefficient of Variation: 1.313510786770889
Minority (rarest occurring value): 0.03
Majority (most frequently occurring value): 0.0
First quartile: 3.35
Third quartile: 42.855000000000004
Interquartile Range (IQR): 39.505

» The above statistics show that the total length of Railway track in India is 60,479.32 KM.
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a. Computation of earthwork

Experiment 8

MS Excel

BCVL606

A railway embankment is to be formed with a width of 12.5 m at the formation level

and a side slope of 2:1. The ground levels at every 50m along the central line are as

under
Distance | 0 50 100 150 200 250 300 350 400
RL 1548 | 1555 | 156.2 156.8 157.5 157.3 157.2 157.9 158.3

The formation level at zero chainage is 157.0 and the embankment has a rising gradient of 1
in 100m. The ground is level across the central line. Calculate the volume of earthwork
using both trapezoidal and prismoidal rules.

Aim:

To tabulate the earthwork of a stretch having a level section by using a spread
sheet application.
Principle: The areas of cross sections may be calculated using the

formula

V =d [(Ai+An)/2+ Az + Az +

A=(b+nh)h
Where, b = width of base and h = height of formation.
Trapezoidal Rule.

Prismoidal Rule.

V =d/3[(A1+4(A2+ As +

) +2(Az + As+....) +An]

No | distances | R. L Rising Filling | Cutting Area
gradient
1 0 154.8 157 -2.2 Al | 37.18
2. 50 155.5 157.5 -2 A2 33
9 A9

Result:

Volume of earthwork using trapezoidal rule =

Volume of earthwork using prismoidal rule =

KLS VDIT, Department of Civil Engineering
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Find the Quantity of earth work for an embankment 180m long and 10m wide at the Top. Side slope is
2:1 and depth at each 30m interval are 0.8, 1.1, 1.2, 1.4, 1.5, 1.6 and 1.3.

10m
2:1
Mean area Method:
Station | Depth | Center Area of Total Area | Mean Interval | Quantity
= i =Sd? | = 2 A1+A
Area=B*d | Sides=Sd B.D+Sd area= % cut il
0 0.8 8 1.28 10.24
30 11 11 2.42 26.62 18.43 30 552.9
60 1.2 12 2.88 34.56 30.59 30 917.7
90 14 14 3.92 54.88 44,72 30 1341.6
120 15 15 45 67.5 61.19 30 1835.7
150 1.6 16 5.12 81.92 74.71 30 2241.3
180 13 13 3.38 43.94 62.93 30 1887.9
Total amount of cut/fill 8777.1m°

Find the Quantity of earth work for an embankment 150m long and 12.5m wide at the Top. Side slope is 2:1
and depth at each 30m interval are 0.4, 1, 1.2, 1.3, 1.2, and 1.5.

10m
2:1
Mean area Method:
Station | Depth | Center Area of Total Area | Mean Interval | Quantity
= ides=Sd? | = 2 A1+A2 .
Area=B*d | Sides=Sd B.D+Sd area= i_ cut A
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b. Design of Horizontal Curve by offset method.

Calculate necessary data using ordinate method at 10m intervals to set out a horizontal

curve of radius 200. Given that the length of long chord is 80m.

Aim: To calculate the ordinates at 10 m interval from the long chord for the given horizontal curve.

Principle: The versing can be calculated which will give the mid ordinate using

2
0p=R- VR2 -1/,

Remaining ordinates are calculated for one half of the curve only since the curve will be

Symmetric about its mid ordinate using.

0, = VR2 — x2 — (R — 0y).

Solution:
x distance Ordinate
Oo = 0=R_\/R2_L/2
02
Ow = 0,= VR2 —x2 — (R - 0p)
O4 =

Result: Necessary ordinates were calculated and an approximate plot is made using excel
chart.

c. Design of Super Elevation

KLS VDIT, Department of Civil Engineering
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Design the rate of super elevation for a horizontal highway curve of radius 220
m and speed 100 km/h.

Aim: To prepare a programmed spread sheet to design the super elevation at a
horizontal curve.
Solution: The scheme of formula writing is written below.

Design of Super Elevation

Allowable Super Elevation 0.07

Allowable Coefficient of Friction (f) | 0.15

Design Speed (V) 100

75% of Design Speed =75 % of Design Speed

Radius of Circular Curve(R) 220

Super Elevation Calculated = V?/225*R

Super Elevation to be provided SE Cal (or) 0.07 whichever is less

f = Friction Developed F =V? (127 * R — Allowable)
Sufficiency of Friction Coefficient af.?ﬁ;ﬁ:g?ﬁlﬁ%%md be less than
Allowable Speed CIJ r]:/:as g‘; {/Sliftl/((:;n; l‘TIth)the speed at

Result:

Super Elevation Provided=................ccooiiiiin. ..
Speed limit proposed = ...
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Demonstration Experiments
Experiment 9

Creating structural model and analysis of high rise structures
Structural Design

The principle elements of an R.C.C building frame consist of:

o Slabsto cover a large area.

o Beams to support slabs and walls.

e Columns to support beams.

« Footings to distribute concentrated column loads over a large of
the supporting soil such that soil bearing capacity is not
exceeded.

e In a framed structure, the load is transferred from slab to beam,
from beam to column, and then to the foundation and soil below
it.

1. Maximum Span of Slabs

Suppo_rt Cantilevers Supported Fixed/Continuous
Condition
One-way One-way O['ra',‘év_ay One-way Two-
Two-way Two-way way way
Maximum
Recommended %gﬂ igﬁ g '05m
span of slabs ‘ ' '

2. Maximum Spans of Beam Carrying Live Load

Beam type | Cantilevers | Supported | Fixed/Continuous
Rectangular 3meters 6meters 8meters
Flanged Smeters 10meters 15meters
Area of Plot 131°.6” x 72°.6”

Number of Floors

G+10
Number of Units 80 (Ground floor parking)
Type Apartment 2BHK

Flat1: 1104 S.ft
Flat 2-4: 1094 S.ft
Flat 5-7: 1163 S.ft

Flat 8: 1173 S.ft

Area of Each Apartment
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Support Generation

Load & Definition X

+ [0 1:SELF WEIGHT

2:WALL LOAD

3 FLOOR FINISH + SLAB LOAD
4:UVE

7: WIND+X

WIND-X

WIND+Z

SERVICEABILITY
COLLAPSE

3111 1. 50LwiNDX)
12 : 1.5(DL-WINDX)
13: 1.5(DL+WINDZ)
14 : 1.5(DL-WINDZ)
15 : 1.2(DL+LL+WINDX)
Cl 16:1.2(DL+LL-WINDX)
iG] 17:1.2(DL+LL+WIND2)
[C 18:1.2(DL+LL-WINDZ)
Load Envelopes

AR EEEEEE

Load Combination

BCVL606
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Dead Load and Live load Load combination on structure

Cument Code: | 1S456
=}y START CONCRETE DESIGN
CODE INDIAN
CLEAR 0.04
CLEAR 0.025
ELY0.S
FC 25000
FYMAIN 500000
FYSEC 500000
TRACK 1
DESIGN BEAM

DESIGN COLUMN
CONCRETE TAKE

P EECSSCKAAA

<
[~ Highlight Assigned Geometry
[C] Toggle Assign

Select Define
Parameters..

Assigning Design parameters
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